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1.1 

 

Introduction  
 

Overview of ProjectWorX 
 
ProcessView contains numerous applications with multiple components, requiring a well-trained 
user in order to successfully create, integrate, deploy, and manage projects. Each of these 
components requires complex setup of many different types of configuration files, databases, and 
OPC servers, as well as runtime and security settings. To simplify the management and deployment 
of the broad spectrum of  ProcessViewapplications, Smar has introduced ProjectWorX, a sort of 
"super configurator" that integrates all  ProcessView applications into a single, easy-to-manage 
format. The ProjectWorX user interface is basically a container embedded in the Microsoft 
Management Console (MMC). The ProjectWorX console conveniently consolidates all of your  
ProcessView files in one easily accessible location, enabling you to: 
 

• Organize all ProcessView application files into separate projects. 

• Create new ProcessView application files and OPC server configurations. 

• Import application files into projects. 

• Start and stop ProcessView applications. 

• Pack project files into a single, compressed file, and unpack project files for easy deployment to 
 multiple computers.  

• Activate entire projects into runtime mode. 

• Control the layout of windows using the Screen Manager. 

• Configure security settings to password-protect projects. 

• Back up project files to Microsoft Visual SourceSafe. 

• Search for and replace machine names and OPC tags throughout all project files using a global 
 find/replace utility. 

• Publish projects to the Web. 

• Control and monitor runtime functions for all applications using ProcViewTray. 

• Launch ProcessView system tools. 

• Generate comprehensive reports for all files and projects. 

• Import and manage third-party applications. (Note: For information about the adding third-party 
 applications to ProjectWorX, please contact mailto:info@Smar.com.) 
 

Starting ProjectWorX 
 
To launch ProjectWorX: 
 
From the Windows Start menu, select Programs > Smar ProcessView > ProjectWorX. 
 
The first time you open ProjectWorX, you are asked to select a folder in which the ProjectWorX 
database will be stored, as shown in the figure below. Browse for a projects folder, and then click 
OK. 
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Main Projects Folder Selection 

 
1. The Smar ProjectWorX Projects console opens in the Microsoft Management Console, as 
 shown in the figure below. This is the main ProjectWorX console that allows you manage your 
 ProcessView projects. This is a split window with a tree control view in the left-hand pane and a 
 configuration view in the right-hand pane.  
 

 
ProjectWorX Console 

 
ProjectWorX Snap-ins and Tree Control  

 
Snap-ins are the basic components of the Microsoft Management Console. Snap-ins always reside 
in a console; they do not run by themselves. The ProjectWorX portion of the console contains snap-
ins that allow you to manage and monitor your ProcessView applications. The tree control (left-hand 
pane) of the ProjectWorX console, shown in the figure below, provides management tools that help 
you organize and monitor your ProcessView applications into projects. The tree control contains the 
following snap-ins:  
 
• Projects: Manages projects and files for all ProcessView applications.  
• ProcViewTray: Monitors the status and settings for ProcessView applications and provides 
 information about which applications are active. 
• System Tools: Includes all the functionality available in the ProcessView tools, such as Dr 
 DCOM, License Monitor, Screen Manager, and the Security Configurator. 
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Tree Control of ProjectWorX Console 

 
Toolbars 

 
The ProjectWorX console contains two different toolbars: the standard Microsoft Management 
Console (MMC) toolbar and the ProjectWorX Snap-in toolbar. For more information on menu 
command functions, please see the Menus section below. 
 
MMC Toolbar 
The MMC toolbar, shown in the figure below, contains the following commands (from left to right): 
 

 
MMC Toolbar 

 
• Back: Moves back to the previous level in the tree view. 
• Forward: Moves forward to the next level in the tree view. 
• Up One Level: Moves up one level in the tree view. 
• Show/Hide Console Tree: Displays/hides the tree control. 
• Cut/Paste: Cuts/pastes the currently selected item. 
• Copy: Copies the currently selected item to the clipboard. 
• Delete: Deletes the currently selected item. 
• Export List: Exports the columns in the MMC console to a text log file. The text file contains 
 the column headers and lists the items in each column. 
• Large Icons: Displays items as large icons. 
• Small Icons: Displays items as small icons. 
• List: Displays items as a list. 
• Details: Displays items as a list with detailed information about the items. 
• Help: Launches the online Help documentation. 
 
Snap-in Toolbar 
The ProjectWorX Snap-in toolbar, shown in the figure below, contains the following commands 
(from left to right): 

 
Snap-in Toolbar 

 
• New Project: Creates a new project under the Projects tree of the ProjectWorX console. 
• Pack Project: Packs the selected project (with all included application files) into a single 
 compressed file. 
• Unpack Project: Unpacks a packed project and imports the project into the ProjectWorX 
 console. 
• Find/Replace: Launches the global find/replace utility, allowing you to search for and replace 
 machine names and OPC tags throughout an entire project. 
• Security Login: Launches the Security Login Utility, which prompts for the user name and 
 password to log into the Security Server. 
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Menus 

 
The menu bar of the ProjectWorX console contains the following menus: 
 
• Action menu 
• View menu 
• Tools menu 
• Help menu 
 

Note 
The Tools menu and the Help menu are completely provided by the ProjectWorX snap-in. The 
Action menu contains both standard MMC commands as well as commands that are specific to 
ProjectWorX. 

 
Action Menu 
The Action menu lists the action commands available for each item and subitem in the ProjectWorX 
console. The Action menu commands vary depending on which item is selected. You can also 
access Action menu commands for each item by right-clicking the item and selecting actions from 
the pop-up (context) menus.  
 
MMC Actions 
The Action menu commands for the MMC are listed in the table below. For additional information 
about these commands, please see the MMC Help documentation. 
 
MMC Action Menu Commands 
 

Command Function 

New Window From Here Opens a new window from the selected root item in the tree 
control. 

Rename Renames the selected item. 

Export List 
Exports the columns in the MMC console to a text log file. The text 
file contains the column headers and lists the items in each 
column. 

Refresh Refreshes the view in the right-hand pane. 
Delete Deletes the selected item. 
Help  Launches the online Help documentation. 

 
Project Actions 
The Action menu commands for the Projects tree are listed in the table below. 
 

Note 
You can also access Action menu commands by right-clicking items in the Projects tree.  

 
Project Action Menu Commands 
 

Command Function 

New Project Creates a new project under the Projects tree of the 
ProjectWorX console. 

Unpack Project Unpacks a packed project and imports the project into the 
ProjectWorX console. 

Pack Project Packs an entire project (with all included application files) into 
a single compressed file. 

Activation Activates the selected project. 

Explore Displays the current project directory in the Windows Explorer 
view. 
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Command Function 

Global Find/Replace Searches for and replaces machine names and OPC tags in 
all the project files. 

Add File to Project Imports an existing file into the project. 
Source Control Provides options for archiving projects in Visual SourceSafe. 

Generate Report Creates a comprehensive report for all files and applications in 
the project. 

Exit ProjectWorX Closes the ProjectWorX console. 

Properties Displays information about the general properties, project files, 
and security settings for each project. 

 
Application-Specific Actions 
Each ProcessView application (e.g. GraphWorX, AlarmWorX, etc.) within a project contains 
application-specific action menus for adding and creating project files. Please see Chapter 3 for 
information about managing application files. 
 
View Menu 
The View menu commands are listed in the table below. 
 
View Menu Commands 
 

Command Function 

Choose Columns 
Hides/displays columns in a detailed list. 
Note: This command is only available when Detail is 
also selected on the View menu. 

Large Icons Displays items as large icons. 
Small Icons Displays items as small icons. 
List Displays items in a list. 

 

Detail Displays items in a list along with detailed information 
about the configuration of each item. 

Customize Opens the Customize View dialog box, which sets the 
ProjectWorX console display settings. 

 
Hiding and Displaying Detail Columns 
Selecting Detail from the View menu displays the items in the selected folder along with detailed 
information about the configuration of each item. In the figure below, for example, the items in the 
My Project folder in the tree control are listed in the right-hand pane of the console by Name, file 
Size, and the date the files were Modified.  
 
Selecting Choose Columns from the View menu opens the Modify Columns dialog box, as shown 
in the figure below. The column names listed in the Displayed Columns list (e.g. Name, Size, and 
Modified) are currently shown in the details view. The column name listed in the Hidden Columns 
list (Reference to) is not shown in the details view. Click the Add and Remove buttons to move 
column names back and forth between the Displayed columns list and Hidden columns list.  
 
To hide a column, in the Displayed columns list click the column you want to hide, and then click 
Remove. To display a column, in the Hidden columns list click the column you want to display, and 
then click Add. To undo a move, click the Reset button. 
 

Note 
Column names may vary per items in the tree control. For additional information, please see the 
MMC Help documentation. 
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Selecting Which Columns To Display in the Details View 

 
Tools Menu 
The Tools menu commands are listed in the table below. 
 
Tools Menu Commands 
 

Command Function 
Put [Active Project] in Runtime Enters the currently active project into runtime. 

Shut Down [Active Project] Stops the currently active project. (Note: This command is 
available in runtime mode only.) 

Machine Startup Configuration Configures the project startup settings for the current computer. 

Runtime Configuration  Configures the runtime layout for the selected project using 
Screen Manager. 

Publish Wizard Launches the Web Publishing Utility. 
Login to SourceSafe Opens the Microsoft Visual SourceSafe login screen. 

Prompt for Comments 

Enters a comment to document each Source Control action for 
backing up files to Microsoft Visual SourceSafe (e.g adding, 
removing, check-in and check-out). For more information about 
ProjecWorX32 Visual SourceSafe integration, please see 
Chapter 5. 

Project Properties Opens the properties for the selected project. 
Compact Database Automatically compacts the ProjectWorX database. 

Change Database Location Changes the folder in which the ProjectWorX database is 
stored. 

 
Compacting the ProjectWorX Database 
The ProjectWorX console data are stored in a Microsoft Access database file called 
ProjectWorX.mdb. ProjectWorX includes a database compacting feature that minimizes the size of 
this file. To minimize the size of this database, select Compact Database from the Tools menu. 
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Changing the Database Location 
You can change the folder in which the ProjectWorX database is stored at any time by selecting 
Change Database Location from the Tools menu, as shown in the figure below. Browse for a 
projects folder, and then click OK. 
 

 
Main Projects Folder Selection 

 
Help Menu 
The Help menu commands are listed in the table below. 
 
Help Menu Commands 
 

Command Shortcut Key Function 
Help Topics F1 Launches the online Help documentation.  

About 
Application  

Launches the About Box, which contains information 
about the product version number, copyright, and 
available disk space. It also contains information about 
how to contact the company.  
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Using the Projects Console 
 

Project Management 
 
The Projects tree in the ProjectWorX console tree control (left-hand pane) is where you manage all 
of your ProcessView project files. Each time you add a new project to the ProjectWorX console, a 
folder is created for that project in the "Bin" directory. From this single location in the ProjectWorX 
console you can conveniently add existing ProcessView application files, create and launch new 
files, and check files into Microsoft Visual SourceSafe. As shown in the figure below, you can create 
multiple projects (e.g. Boiler Room, Power Plant, and Factory).  
 

 
Projects Snap-in in ProjectWorX Console 

 
Organization of Project Folders 
The top-level tree for each project contains two primary subtrees: Applications and OPC Servers, 
as shown in the figure below. Each project also contains a "ProjInfo.ini" file, which an initialization 
file that contains information about the project, as well as a .sec file, which is the Security Server 
configuration file for the project. For more information about project security, please see the 
Enabling Project Password Protection section below. 
 

 
Main Projects Tree Control and Files 

 
Application Files 
The Applications tree for each project contains all ProcessView client applications and 
components, including GraphWorX, AlarmWorX, TrendWorX, DataWorX, ScriptWorX, MobileHMI, 
Screen Manager, GenBroker, and ReportWorX.NET, as shown in the figure below. Each of these 
applications has several additional modules or components (e.g. AlarmWorX Container, Logger 
Configurator, Server Configurator, and Multimedia Configurator).  
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Project Applications Tree 

 
OPC Server Configurations 
The OPC Servers tree for each project, shown in the figure below, allows you to create and manage 
OPC server configurations. Each time you create a new OPC server configuration inside a project in 
the OPC Servers tree, the new file is saved to the project folder in the "Bin" directory. If you add an 
existing configuration file, you have the option of copying the file to the project folder or running the 
file from its current location. 
 

Note 
ProjectWorX currently supports configuration for the Simulator OPC Server only, which is installed 
with ProcessView. All other OPC servers (e.g. DataStore OPC Server, etc.) must be installed 
before you can configure them through ProjectWorX. 

 

 
Project OPC Servers 
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Creating a New Project 

 
To create a new project in the ProjectWorX console: 
 
1. Right-click the Projects folder in the tree control and select New Project from the pop-up menu, 
 as shown in the figure below. 
 

 
Creating a New Project 

 
2. The new project appears under the Projects folder, as shown in the figure below. To rename 
 the project, right-click the project name and select Rename from the pop-up menu, as shown in 
 the figure below. Give the project a new name and press Enter. 
 

 
 

Renaming the New Project 
 
3. A message box appears asking you to confirm the project rename. Click Yes to rename the 
 project.  
 

Note 
If you are using multiple projects and the other projects contain references to the project you are 
renaming, those references will be lost. 

 

 
Confirming the Project Rename 
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Importing Files Into a Project 

 
ProjectWorX allows you to import files (of any type) into projects. You can import single files or 
multiple files at once. 
 
To add a file to a project in the ProjectWorX console: 
 
1. Right-click the project and select Add File to Project from the pop-up menu, as shown in the 
 figure below. 
 

 
Importing a File Into a Project 

 
2. In the Add file dialog box, choose a directory and a file to import, as shown in the figure below. 
 Click Open. 
 

 
Choosing a File To Add to the Project 

 
3. When you import a file into a project, you can copy the file to the local project directory instead 
 of running the file from its current location. To copy the file to the project folder, click Yes in the 
 message box shown in the figure below.  
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Note 

If you import a file and choose not to copy the file to the project folder, ProjectWorX runs the file 
from its current location, and the file's directory path is indicated in the Reference to column the 
right-hand pane of the ProjectWorX console. 

 

 
Copying the File Into the Project Folder 

 
4. The file is added to the project tree and is displayed in the right-hand pane of the ProjectWorX 
 console, as shown in the figure below. Files added to the project have four properties: 
 
• File name. 

• File size. 

• Date of the last modification. 

• Reference to the directory where the file is located (if the file does not reside in the project 
 folder).  
 

 
Files Imported Into Project 

 
Note 

If you manually a copy file to a project folder in Windows Explorer, the next time you open that 
project in the ProjectWorX console ProjectWorX will detect the file and ask you whether to import 
the file into the project, as shown in the figure below. If you click Yes, the file is added to the 
project tree and is displayed in the right-hand pane of the ProjectWorX console. If you click No, the 
file remains in the project folder but is not imported into to the project and is not displayed in the 
ProjectWorX console. However, this does not apply to unpacking_log.txt, packing_log.txt and all 
.mdb and .udl files. 

 



 Using the Projects Console 
   

2.6 

 

 
Adding Copied Files to Project 

 
Managing Project Files 

 
All the files in a project can be handled through a pop-up menu available by right-clicking on the file 
name, as shown in the figure below. The commands available for each file depend on the file type. 
Generic files can be opened, duplicated, renamed, deleted, etc., while the Packing Log can only be 
opened and deleted. Drag-and-drop and cut-and-paste functions in the ProjectWorX console are 
similar to those in Windows Explorer, but you can paste and drop files only between trees of the 
same type. For example, a GraphWorX display file from the GraphWorX tree cannot be copied to 
the AlarmWorX tree. 
 
You can also make the file Read-only so that it cannot be modified. An additional Add to Source 
Control option allows you to check files into Microsoft Visual SourceSafe. For more information 
about the Source Control option, please see Chapter 5. 
 

 
Context Menu for a Generic Project File 
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Deleting Project Files 
To delete a project file from the ProjectWorX console: 
 
1. Right-click the file and select Delete from the pop-up menu, as shown in the figure below. 
 

 
Deleting a Project File 

 
2. A message box appears asking you whether to delete the file, as shown in the figure below. 
 Click Yes to delete the file. 
 

 
Confirming File Deletion 

 
3. A second message box appears asking you whether you want to delete the file from the disk, as 
 shown in the figure below. If you click Yes, the file is deleted entirely from the project folder. If 
 you click No, the folder is hidden from the ProjectWorX console but remains inside the project 
 folder. 
 

 
Confirming Deletion of File From Project Folder 

 
Note 

Deleting a Microsoft SQL Server database configuration file from a project (e.g. for MobileHMI and 
AlarmWorX Multimedia) will delete it only from the project, not from SQL Server. (The .udl file will 
not be deleted as well.)  
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Renaming Project Files 
To rename a project file in the ProjectWorX console: 
 
1. Right-click the file and select Rename from the pop-up menu, as shown in the figure below. 
 

 
Renaming a Project File 

 
2. The file name field becomes modifiable. Type a new name for the file, as shown in the figure 
 below. Press the Enter key. 
 

 

Typing a New Name for the File 

 
Duplicating Project Files 
To make a copy of a project file in the ProjectWorX console: 
 
1. Right-click the file and select Duplicate File from the pop-up menu, as shown in the figure 
 below. 
 
 
 
 



ProjectWorX 

2.9 

 
Duplicating a Project File 

 
2. A copy of the file appears, as shown in the figure below. You can rename the copy of the file or 
 move the copy to a different project directory. 
 

Note 
Drag-and-drop and cut-and-paste functions in the ProjectWorX console are similar to those in 
Windows Explorer, but you can paste and drop files only between trees of the same type. For 
example, a GraphWorX display file from the GraphWorX tree cannot be copied to the AlarmWorX 
tree. 

 

 
File Copied to Project Folder 

 
Packing and Unpacking Projects 

 
The pack/unpack projects feature of the ProjectWorX console allows you to pack up an entire 
project (with all included application files) into a single, compressed file. This is especially useful for 
system administrators who want to configure a project and then send or copy the project to several 
different computers (e.g. nodes on a network). Then the packed file can be unpacked and run on 
each computer. 
 
Packing Projects 
To pack a project in the ProjectWorX console: 
 
1. Right-click the project in the tree control and select Pack Project from the pop-up menu, as 
 shown in the figure below. 
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Packing a Project 

 
2. Choose a directory in which to save the packed project (.pwx) file, as shown in the figure below. 
 Give the file a name in the File Name field, and then click Save. 
 

 
Saving the Packed Project 

 
3. Once the project has been packed, a confirmation message appears, as shown in the figure 
 below. Click OK. 
 

 
Project Successfully Packed 

 
4. A packing log (HTML) file opens listing the packed files as well as any errors or warnings.  
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Unpacking Projects 
To unpack (import) a packed project in the ProjectWorX console: 
 
1. Right-click the project in the tree control and select Unpack Project from the pop-up menu, as 
 shown in the figure below. 
 

 
Unpacking a Project 

 
2. Choose a packed ProjectWorX project (.pwx) file, as shown in the figure below. Then click 
 Open.   
 

 
Selecting a Project File to Unpack 

 
3. You will be asked permission to modify pathways to match the new directory location of the 
 unpacked project. If you click Yes, the paths will be changed. If you click No, the project will 
 retain its original directory paths. 
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Modifying File Pathways 

 
4. Once the project has been unpacked, a confirmation message appears, as shown in the figure 
 below. Click OK. 
 

 
Project Successfully Unpacked 

 
5. An unpacking log (HTML) file opens listing the unpacked files as well as any errors or warnings. 
 
Unpacking Existing Projects  
ProjectWorX includes a feature that allows you to overwrite an existing project by unpacking a 
newer version of that project. For example, if a system administrator makes changes to a project 
and needs to deploy an updated version of the project to multiple users on different network nodes, 
each user on each node can unpack and automatically update the project.  
 
When you unpack a packaged (updated) version of an existing project (i.e. a project with the same 
name) in the ProjectWorX Console, ProjectWorX scans each file in the packaged project. 
ProjectWorX automatically unpacks any new files in the packaged project (i.e. files that have been 
added to the project since the last version). For packaged files that already exist (i.e. with the same 
name) inside the project, ProjectWorX also checks the date/time of the files. If the date/time of a 
packaged file is the same as the date/time of the existing file of the same name, nothing happens. If 
a packaged file is newer (i.e. more recent date/time) than the existing file of the same name, 
ProjectWorX automatically unpacks the newer file and overwrites the existing file. If a packaged file 
is older than the existing file of the same name, ProjectWorX warns you of this fact and gives you 
the option to overwrite the file.  
 

Note 
Difference unpacking of projects will not work for Microsoft SQL Server databases. When 
unpacking SQL-based configuration files, the files will not be overwritten even if the packed project 
contains newer files of the same name. 

 
Unpacking Projects That Contain SQL Configuration Databases 
ProjectWorX makes it possible to import configuration databases that reside inside Microsoft SQL 
Server databases. Several ProcessView applications, such as MobileHMI, AlarmWorX Multimedia, 
and ReportWorX.NET, use SQL configuration databases. Universal Data Link (.udl) files are used to 
connect to the Microsoft SQL Server database. When you unpack a project that contains a SQL 
Server configuration database, ProjectWorX checks to see whether SQL Server is present on the 
local machine, and tries to connect to the server via integrated security (thus relieving the user from 
to have to enter login information). If SQL Server is not present on the local machine, then 
ProjectWorX ask you if you want to scan the network for an instance of SQL Server, as shown in the 
figure below. Click Yes to search for a SQL Server. 
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ProjectWorX Searching for Available SQL Server 

 
In the SQL Server Login dialog box, select a server from the drop-down list and enter your login ID 
and password (if applicable). Then click OK.  
 

 
Changing the SQL Server 

 
ProjectWorX checks to see if any existing databases have the same as the database being 
unpacked. If so, you are prompted to change the database name prior to unpacking, as shown in 
the figure below. To continue unpacking the project, enter a new name for the database and then 
click OK. To discontinue unpacking, click the Skip button. 
 

 
Renaming a SQL Server Configuration Database 

 
Log Files for Packed and Unpacked Projects 
When projects are packed or unpacked, a packing log or an unpacking log is created in the project 
folder, as shown in the figure below. These files contain useful information about what has been 
packed\unpacked, including any errors and warnings issued during the process.  
 

Note 
Any referenced files in a project are also packed/unpacked. When unpacking the project, all the 
referenced files (which are listed with a warning in the packing log file) are placed in the same 
location as they were initially. ProjectWorX tries to recreate the locations necessary for referenced 
external files (i.e. files that are located in a directory outside the project folder). Referenced files 
that are located in a subfolder within the project folder are unpacked into the subfolder.  
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Packing/Unpacking Log Files in Project Folder 

 
Viewing Project Properties 
To view or change the settings for a project in the ProjectWorX console: 
 
1. Right-click the project in the tree control and select Properties from the pop-up menu, as shown 
 in the figure below. 
 

 
Viewing the Project Properties 

 
2. This opens the Properties dialog box for the project, which contains the following tabs: 
 
• General  
• Summary 
• Project Files  
• Password Protection 
 
General Tab 
The General tab of the project Properties dialog box, shown in the figure below, contains the 
following fields.  
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Project Properties: General Tab 

 
• Name: Displays the project name as it is shown in the Projects tree of the ProjectWorX 
 console.  
 

Note 
You cannot rename the project in the Properties dialog box. To rename a project, you must right-
click the project in the Projects tree of the ProjectWorX console and select Rename from the pop-
up menu. 

 
• Location: Displays the directory path for the project folder. 
• Title: Optional field used to describe the project or to provide an alternate or expanded name 
 for the project. 
• Project Version: If you have multiple revisions of the project, you can give each revision a 
 version number. 
• ProjectWorX Version: Displays the ProjectWorX version number with which the project was 
 created. (This is important for compatibility with future ProjectWorX versions.) 
• Date: Displays the reference date for the project. 
• Time: Displays the reference time for the project. 
 

Note 
The Project Version, Date, and Time fields are completely modifiable, and there are no 
restrictions on the data formats. 

 
Click the Apply button to save any changes to these fields. 
 
Summary Tab 
The Summary tab of the project Properties dialog box, shown in the figure below, contains the 
following fields.  
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Project Properties: Summary Tab 

 
• Project Author: Name of the person who created the project. 
• Last Modification By: Name of the person who made the most recent change to the project. 
• Last Modification Timestamp: Every time a change is made to the project (e.g. adding or 
 removing a file), this field automatically displays the time and date of the change.  
• Comments: Provides a blank field for user comments or project descriptions.  
 
Click the Apply button to save any changes to these fields. 
 
Project Files Tab 
The Project Files tab of the project Properties dialog box, shown in the figure below, contains 
three columns: Status, File Name, and File Type. 
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Project Properties: Project Files Tab 

 
The Status column indicates the following general status of the project files as follows: 
 

• Present (in green type): The file is found in the directory path indicated in the File Name 
 column.  

• Missing (in boldface red type): The file cannot be found in the specified path. If any files are 
 missing, a warning message is displayed (in boldface red type) in the lower left indicating the 
 number of broken (missing) file links in the project. 

 
If you add a SQL database (e.g. MobileHMI or ReportWorX.NET configuration database), you could 
have other states reflecting the database status: 
 
• Can't login: The database exists, but the user does not have the access rights to log in into it. 
• Offline: Database is currently offline.  
• Loading: Database is currently loading.  
• Recovering: Database is recovering.  
• Suspect: Database is suspect and then offline. 
• Unreachable: Database is not available because of an unknown error. 
 
The File Name column lists the directory path and name for every file in the project (regardless of 
the file status). 
 
The File Type column provides information about the file type (e.g. GraphWorX display, AlarmWorX 
container, etc.). 
 
Clicking the Refresh List button allows you to dynamically update the files list without having to 
close and reopen the Properties dialog box (i.e. when trying to resolve broken links). 
 
Password Protection Tab 
The Password Protection tab of the project Properties dialog box, shown in the figure below, is 
used to set the password for each project. This password protects the project from being: 
 
• Accessed through ProjectWorX. 
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• Unpacked into ProjectWorX. 
 
The project password protection is disabled by default, as shown in the figure below. 
 

Note 
The project files on the hard drive and the project folder are NOT protected by this password.  

 

 
Project Properties: Password Protection Tab 

 
Enabling Project Password Protection 
To enable password protection for a project, in the Password Protection tab of the project 
Properties dialog: 
 
1. Type a password in the New Password field. 
2. Retype the password in the Repeat Password field.  
3. Click the Apply button.  
4. The password is now enabled, and a message appears stating: "This project is password 
 protected," as shown in the figure below. Click OK. 
 

Note 
Passwords are case-sensitive. Once password protection is enabled, the user must also provide 
the Old Password when changing the password. 

 
 
 



ProjectWorX 

2.19 

 
Enabling Project Password Protection 

 
Once a project is password-protected, the project's protected status is indicated by a red circle with 
a slash through it, as shown in the figure below. The next time you try to access the project, you are 
prompted to enter the password, as shown in the figure below. Enter the password and click OK to 
gain access to the project. 
 

 
Logging Into a Password-Protected Project 

 
Using the Global Find and Replace Utility 

 
The Global Find/Replace Utility in ProjectWorX provides a project-wide function to search for and 
replace machine names, OPC tags, and trend pens throughout all files in a project. The utility 
applies only to files included in the specified project folder.  
 
To use the Global Find\Replace Utility: 
 
1. Right-click a project in the Projects tree of the ProjectWorX console and select Global 
 Find/Replace from the pop-up menu, as shown in the figure below. 
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Starting the Global Find/Replace Utility 

 
2. The Global Find\Replace Utility dialog box opens, as shown in the figure below. This dialog is 
 similar to the Change Host Name Utility in WebHMI. You can choose the project folder by 
 clicking the button to the right of the Working Directory field. 
 

 
Global Find/Replace Utility 

 
3. Choose the type of file to search for by clicking on the check boxes in the File Types column, 
 as shown in the figure above. Functioning like any "find-and-replace" command, the Global 
 Find/Replace Utility in ProjectWorX searches the following file types: 
 
• HTML pages 
• Text files 
• GraphWorX displays 
• TrendWorX Viewer  
• AlarmWorX Viewer  
• GenBroker  
• DataWorX  
• TrendWorX Configurator configuration database 
• AlarmWorX Server configuration database 
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• AlarmWorX Logger configuration database 
• AlarmWorX Multimedia configuration database 
• MobileHMI configuration database 
• Language Aliasing Configurator configuration database (Unicode version only) 
• Global Aliasing Configurator configuration database 
• ReportWorX.NET configuration database 
• OPC Server configurations 
• Microsoft Excel spreadsheets 
 
4. The Global Find/Replace Utility searches for the text typed in the Find what field and replaces it 
 with the text typed in the Replace with field, as shown in the figure below.  
 

 
Specifying Search Parameters 

 
5. Choose from the following search parameters: 
 
• Match case: Performs a case-sensitive search. 
 
• Node name only: Uses Find String and Replace String and adds "\\" or "//" at the beginning 
 and "\" or "/" at the end of these strings. This confirms that you have really replaced network 
 node (machine) names. You can modify the AlarmWorX files and GenBroker Configuration files 
 only by selecting Node name only.  There is no other text information that you can change. The 
 check boxes for the AlarmWorX and GenBroker Configuration files are grayed out if the Node 
 name only check box is not checked. Thus, when you uncheck Node name only, you can use 
 the Global Find/Replace Utility to change, for example, a point name in GraphWorX displays 
 and TrendWorX files at the same time. You must then enter the original name in the Find What 
 field and the new name in the Replace with field. 
 
6. The three radio buttons (MS Network, DNS or IP Address) allow you to change the name or 
 address in the Replace with field. A node name or IP address appears in the Replace with 
 field if you select one of these options, as shown in the figure below.  
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Microsoft Network Option 

 
Using the Global Search Feature 
In addition to the find/replace function, ProjectWorX allows you to perform a basic search operation 
(e.g. for an OPC tag) across files in a project. An example search is described below: 
 
1. Create one or more GraphWorX displays in a project.  
2. For each display, map one or more tags to a simulated tag, such as "gfwsim.ramp.long."  
3. Right-click on the project and select Global Find/Replace from the pop-up menu, as shown in 
 the figure below. 
 

 
Starting the Global Find/Replace Utility 

 
4. This opens the find/replace dialog box. Click on the Search tab, as shown in the figure below, 
 and type "gfwsim" in the Find what field. Click the Search button. 
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Performing a Global Search 

 
5. The Search Results dialog box appears, as shown in the figure below. This dialog lists all 
 GraphWorX displays (file name, file type, and directory path) in the project that contain the 
 search parameter "gfwsim." Double-clicking on any of these displays will launch the display. 
 

Note 
GraphWorX displays are used here as an example. The global search feature works for all file 
types listed in the box on the right hand side of the Search dialog box. 

 

 
Viewing the Global Search Results 
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Activating and Running Projects 

 
The ProjectWorX console enables you to create and manage multiple ProcessView projects, each 
of which may contain many different types of application files. Only one project can be put into 
runtime mode at a time. In order to enter a project into runtime mode, you must first designate the 
project as the currently active project. When you make a project active in the ProjectWorX console, 
all the connected included databases that are active for the project and all the settings to properly 
set up the ProcViewTray are "made active" on the current machine. If there are multiple 
configuration databases for a single application within the active project, only the active database for 
that application will enter runtime mode. 
 
Making a Project Active 
To make a project active in the ProjectWorX console: 
 
1. Right-click the project in the tree control and select Activation > Make Project Active from the 
 pop-up menu, as shown in the figure below. 
 

 
Making a Project Active 

 
2. A dialog box appears confirming that the project is now active, as shown in the figure below. 
 This dialog box provides a final report after activating the project. Click OK. 
 

Note 
You can also view the activation report at any time by choosing select Activation > Make Active 
List from the pop-up menu, as shown in the figure above. Click Print if you want to print out the 
activation report. 

 

 
Project Activation Confirmed in the Activation List 
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3. The icon for the project is now green to indicate that it is the currently active project, as shown in 
 the figure below. 
 

Note 
Activating a project does NOT set the active project into runtime mode. For information about how 
to enter a project into runtime mode, see Starting the Active Project below. 

 

 
Active Project Indicated by Green Icon in ProjectWorX Console 

 
Starting the Active Project 
Once you have activated a project, you can enter the entire project into runtime by selecting Put 
[Project Name] in Runtime from the Tools menu, as shown in the figure below. The name of the 
currently active project appears in the Tools menu command. In the example shown below, the 
project called "Factory" is the currently active project, so selecting Put 'Factory' in Runtime from 
the Tools menu enters the project into runtime mode. 
 

 
 

Starting the Active Project 
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Stopping the Active Project 
To take the active project out of runtime mode, select Shut Down [Project Name] from the Tools 
menu, as shown in the figure below. The name of the currently running, active project appears in the 
Tools menu command. In the example shown below, the project called "Factory" is the currently 
running active project, so selecting Shut Down 'Factory' from the Tools menu stops the project. 
 

 
Stopping the Active Project 

 
Machine Startup and Project Runtime Settings 
In the Tools menu, particular attention must be given to the Machine Startup Configuration. 
Selecting Machine Startup Configuration from the Tools menu opens the Machine 
Configuration for the Active Project dialog box, as shown in the figure below. These startup 
settings apply to the computer on which the active ProjectWorX project is currently running. This 
means that the dialog startup settings are applied to the currently active project for that computer. 
Thus, if the active project changes after some of these settings have been decided, then the settings 
will automatically be applied to the newly activated project.  
 

 
Machine Startup Settings 

 
Checking Place a "Project Startup" icon on the Desktop creates a shortcut to the ProcViewTray 
application on your computer's desktop. ProcViewTray is used to launch ProcessView applications 
from the Windows taskbar. 
 
The following runtime options are available for the active project: 
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• Do not automatically start the Active Project: When selected, the active project must be 
 started manually by choosing Put [Active Project] in Runtime from the Tools menu. 
 

• Start Active Project when the current user logs in: When selected, the active project is 
 entered into runtime mode when the current user logs into the Security Server. 

• Start Active Project when any user logs in: When selected, the active project is entered into 
 runtime mode when any user logs into the Security Server. 

• Start Active Project with unattended login: When selected, the active project is entered into 
 runtime mode even if no one logs into the computer. 
 

Generating Reports 
 
ProjectWorX allows you to automatically create HTML reports by simply selecting a menu from the 
ProjectWorX console. From any point in the ProjectWorX tree, you can right-click on an item and 
select Generate Report from the pop-up menu, as shown in the figure below.  An HTML report of all 
applications at or below the selected item will be generated. The report lists any files, if they exist, in 
a table along with their sizes and dates modified. The closer to the root that one generates a report, 
the more items the report will cover. For example, clicking the GraphWorX tree will generate a report 
that covers displays, templates, and symbols. Clicking the Applications tree will generate a report 
that covers every application, including its respective components, under the Applications tree. 
 
To create a report: 
 
1. Right-click an item in the ProjectWorX console tree control and select Generate Report from 
 the pop-up menu, as shown in the figure below.   
 

 
Creating a Report 

 
2. A message box will ask whether to generate an Exhaustive report, as shown in the figure 
below. If you select No, then the report will not go any further than reporting the files contained 
within the tree.  If you select Yes, then the report will find all OPC tags within GraphWorX displays, 
TrendWorX configuration databases, and Alarm Server configuration databases and list them below 
each respective item listed in the report.   
 

Note 
An exhaustive report can take substantially longer to create than a nonexhaustive report. 
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Exhaustive Report 

 
3. A report for the selected item is generated in an HTML file, as shown in the figure below. This 
 particular report was generated by selecting Generate Report at the root of the Applications 
 tree for a project called "Factory."  Each tree item underlined in boldface blue type can be 
 clicked to expand/contract its child branches.  (Items will not be expanded, however, if they 
 have no children.  For example, there may be no GraphWorX displays, and therefore, clicking 
 on "Displays" will do nothing.)  The top of the report contains a title, a date, and summary 
 information on the number of files and total size of all items in the project.  
 
In an exhaustive report, all of the OPC tags contained within a display are shown under the 
appropriate display files.  In this case, clicking on a file name will collapse the tags seen, and 
clicking on it again will expand those tags.  
 

Note 
Any files that are in the project, but physically missing, will appear in boldface red type.  
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HTML Report Generated 

 
Customizing the Projects View 

 
You can customize the appearance of the tree control for each project by choosing which 
Applications or OPC Servers to display and the order in which to display them. 
  
To customize the projects view: 
 
1. Right-click the Applications tree or the OPC Servers tree and select Customize from the pop-
 up menu, as shown in the figure below. 
 

 
Customizing the Projects View 
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2. This opens the Show/Hide dialog box, as shown in the figure below. The checked items 
 currently appear in the ProjectWorX console. To hide an application from the tree control, simply 
 uncheck the item in the dialog box. If the Make Default for All New Projects check box is 
 checked, the Show/Hide settings will be automatically be applied to all new projects created 
 thereafter. Click OK. 
 

 
Choosing Which Applications to Hide/Display 

 
Note 

You have the option of displaying the Microsoft (MS) Office tree. This tree manages files for 
Microsoft Word, Microsoft PowerPoint, Microsoft Excel, and Microsoft Access. When enabled in 
the Show/Hide Applications dialog box, the MS Office tree is displayed under the project 
Applications tree. 

 
Note 

By default, only currently installed OPC servers are displayed in the OPC Servers tree of the 
ProjectWorX console. To disable this default setting, uncheck the Use Only Installed OPC 
Servers check box in the Show/Hide OPC Servers dialog box, as shown in the figure above. 

 
Adding Custom Items to the Projects Tree 
ProjectWorX has the ability to detect and add additional products to either the “Applications” node or 
the “OPC Server” node in a project. Adding additional products, however, requires that one supply 
the appropriate icons and string constants to ProjectWorX. Moreover, one must supply custom code 
to interface with the application being added (how to launch the application, how to perform custom 
actions, etc, Boolean values for which custom actions are supported, etc.) Smar has a Microsoft 
Visual C++ plug-in, serving as a “New Workspace” wizard, that generates a skeleton workspace 
which, when compiled, will add a custom application to ProjectWorX. This feature is not provided 
with the standard ProcessView 7.0 installation. Please contact Smar Tech Support for more 
information on this custom application toolkit. 
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3.1 

Managing Application Files 
 

Overview of Application Folders and Files 
 
The top-level tree for each project in the ProjectWorX console contains two primary subtrees: 
Applications and OPC Servers. The Applications tree for each project, shown in the figure below, 
contains all ProcessView client applications and components, as shown in the figure below: 
 
• AlarmWorX 
• DataWorX 
• GenBroker 
• ProcViewTray 
• Global Aliasing  
• GraphWorX 
• Language Aliasing (Unicode version only) 
• Microsoft (MS) Office 
• MobileHMI 
• My Files 
• ReportWorX.NET 
• Screen Manager 
• ScriptWorX 
• TrendWorX 
• WebHMI 
 
Each of these application trees has several additional modules or components. For example, the 
AlarmWorX tree contains files for the AlarmWorX Container, Logger Configurator, Server 
Configurator, and Multimedia Configurator.) 
 

Note 
For detailed information about each application, please see the application's Help file. 
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Project Applications Tree 
 

Adding and Creating Application Files 
 
The Applications tree in the ProjectWorX console allows you to manage your ProcessView projects 
by adding or creating new files for each application component.   
 
Creating a New Application File 
Each time you create a new application file inside a project in the Applications tree of the 
ProjectWorX console, the new file is saved to the main project directory. Although the file types vary 
with each ProcessView application (e.g. display files, Microsoft Access configuration databases, 
etc.), the following method for creating new application files is the generally the same for each 
application in the ProjectWorX console. An example is shown below using the AlarmWorX 
Container: 
 

Note 
Microsoft SQL Server configuration files are handled differently. Please see "Adding a SQL Server 
Configuration Database to a Project" below for more information. 

 
1. Right-click the desired component (e.g. Alarm Container) in the application tree (e.g. 
 AlarmWorX) in the ProjectWorX console and select New [File Type] (e.g. New AWX Container) 
 from the pop-up menu, as shown in the figure below. 
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Creating a New Application File in a Project 

 
2. Give the new file a name, as shown in the figure below. Click OK. 
 

 
Naming the New File 

 
3. The new file appears in the component tree (in this case Alarm Container) and is displayed in 
 the right-hand pane of the ProjectWorX console, as shown in the figure below. ProjectWorX 
 automatically launches the new file in the selected application (Alarm Container). 
 

 
File Added to Application Component Tree in Project 

 
Adding an Application File to a Project 
When you add an existing application file to a project in the Applications tree of the ProjectWorX 
console, you have the option of copying the file to the project folder or running the file from its 
current location. Although the file types vary with each ProcessView application, the following 
method for adding existing application files is the generally the same for each application in the 
ProjectWorX console.  
 

Note 
The method for adding Microsoft Access configuration databases is generally the same as the 
method for adding application files.  

 
An example is shown below using the AlarmWorX Container: 
 
1. Right-click the project and select Add [File Type] from the pop-up menu, as shown in the figure 
 below. 
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Adding an Existing Application File to a Project 
 
2. In the Add file dialog box, choose a directory and a file to import, as shown in the figure below. 
 Click Open. 
 

 
Choosing an Application File to Add to the Project 

 
3. When you add an existing application file to a project, you can copy the file to the local project 
 directory instead of running the file from its current location. To copy the file to the project folder, 
 click Yes in the message box shown in the figure below. Otherwise click No to run the file from 
 its current location; the file's directory path is referenced in the right-hand pane of the 
 ProjectWorX console. 
 

 
Copying the Application File Into the Project Folder 

 
4. The file appears in the component tree (in this case Alarm Container) and is displayed in the 
 right-hand pane of the ProjectWorX console, as shown in the figure below.  
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File Added to Application Component Tree in Project 

 
5. To launch the application file, either double-click the file or right-click the file and select Open 
 from the pop-up menu, as shown in the figure below.  
 

 
 

Opening an Application File 
 
Adding a SQL Server Configuration Database to a Project 
ProjectWorX makes it possible to import configuration databases that reside inside Microsoft SQL 
Server databases. Several ProcessView applications, such as MobileHMI, AlarmWorX Multimedia, 
and ReportWorX.NET, use SQL configuration databases. Universal Data Link (.udl) files are used to 
connect to the Microsoft SQL Server database.  
 

Note 
Deleting a Microsoft SQL Server database configuration file from a project will delete it only from 
the project, not from SQL Server. (The .udl file will not be deleted as well.)  

 
The following conditions apply to SQL Server configuration databases in ProjectWorX: 
 
• ProjectWorX will not accept SQL Server configuration databases whose file names contain 
 spaces because Microsoft SQL Server 2000 is not able to bulk export such databases. 
• If a SQL configuration has dependent files (e.g. image files, sound files, etc.), these files will be 
 packed along with the project automatically as referenced files. 
• If ProjectWorX is used to perform certain operations on configurations while an instance of the 
 configurator is open, a dialog box will be shown asking the user to close the configurator. 
 ProjectWorX is blocked until the configurator is closed. 
• Difference unpacking of projects will not work for SQL-based configurations. When unpacking 
 SQL configuration files, all SQL configurations will not be overwritten even if the packed project 
 contains newer files of the same name. 
 
To add a SQL configuration database to a project: 
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1. Right-click the configuration tree and select Add Configuration, as shown in the figure below. 
 

 
Adding a SQL Server Configuration Database 

 
2. In the Add UDL Files dialog box, select a .udl file and click Open to add the configuration 
 database to the current project.  
 
3. The configuration database appears in the configurations subtree in the right-hand pane of the 
 ProjectWorX console. The details view lists the following properties for the configuration 
 database: 
 
• Configuration Database: Name of the database 

• On Server: Name of the SQL Server in which the database was created 

• Status: The status of the database (could be normal, offline, etc) 

• Linked UDL File: The path to the UDL file used to identify the database 
 
4. The new file appears in the right-hand pane of the ProjectWorX console, as shown in the figure 
 below. If you right-click the file, the Create UDL File option is normally grayed out, as shown in 
 the figure below. If the link to the .udl file is ever broken inside the ProjectWorX database, the 
 Create UDL File option will become available and you will be able to create a new .udl file for 
 the configuration. 
 

 
 

Configuration File Added 
 
Checking the Database Status 
The Check Database Status option is useful for checking the status of all the Microsoft SQL Server 
databases added to the project. ProjectWorX does not poll SQL Server regularly to get the database 
status, so a “Normal” status will always be displayed even if the database is offline. By using the 
check status option, the list of databases will be refreshed and any eventual problem will be 
displayed. 
 
To get the status of a SQL Server database, right-click and select Check Database Status from the 
pop-up menu, as shown in the figure below.  
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Checking the Database Status 

 
The status of the database is indicated as follows: 
 

• Normal: The database is online and ready 
• Missing: The database is no longer on the server. 
• Offline: The database is still on the server but is currently offline. 
• Recovering: The database is recovering.  
• Loading: The database is currently loading and will be available soon. 
• Suspect: The database may have become corrupt. 
• Not Available: An unknown error has occurred and the database is not available. 

 
Activating Configuration Databases 
Some application configurators (e.g. MobileHMI, Alarm Server, Alarm Logger, Alarm Multimedia, 
and Trend Logger) provide an option to specify an active configuration database. 
 

Note 
For active Microsoft SQL Server configuration databases, information is stored inside the 
ProjectWorX database and is not subject to continuous polling. If the active configuration is 
changed from outside ProjectWorX (e.g. with the MobileHMI Configurator) you will have to refresh 
the view by right-clicking and selecting Refresh from the pop-up menu. This updates ProjectWorX 
with the new database status. 

 
To activate a configuration database: 
 
1. Right-click the configuration database and select Make Configuration Active from the pop-up 
 menu, as shown in the figure below. 
 

 
 

Specifying the Active Configuration Database 
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2. The icon next to the configuration file changes from the standard icon to a globe icon to indicate 
 that it is active, as shown in the figure below.  
 

 

Configuration Database Activated 
 
OPC Tag Verification 
The ProjectWorX Console includes a feature that lists all of the OPC tags that belong to certain files:  
 
1. For example, right-click a GraphWorX display file in the ProjectWorX Console and select List 
 OPC Tags from the pop-up menu, as shown in the figure below. 
 

 
 

Opening the Tag Verification Utility 
 
2. This opens the Tag Verification Utility, which lists all OPC tags contained within the display file. 
 You can verify the status of tags in one of three ways: 
 
• Double-click a tag under OPC Tag Name. 
• Select one or more tags under OPC Tag Name and click the Verify Selected button.  
• Click the Verify All button to check the status of all tags in the display file.  
• Click Export List to export the data to a text file. 
 
Each of the tags selected for verification shows an indicator of good (green), bad (red), or uncertain 
(yellow) as a form of verification, as shown in the figure below. 
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Verifying OPC Tags 

 
GraphWorX Tree 

 
The GraphWorX tree in the ProjectWorX console, shown in the figure below, manages files for the 
following GraphWorX components:  
 
• Displays 
• Templates 
• Symbols  
• VBA Wizards 
 

 
GraphWorX Tree in ProjectWorX Console 



Managing Application Files 
 

3.10 

 
GraphWorX Displays 
The Displays subtree component of the GraphWorX tree in the ProjectWorX console, shown in the 
figure below, includes all the GraphWorX display files available for a project. From here you can 
right-click and create new GraphWorX display files or add existing display files to the project. 
 

 
GraphWorX Displays Subtree 

 
Creating a New GraphWorX Display File 
 
To create a new GraphWorX display file in the ProjectWorX console: 
 
1. Right-click Displays in the GraphWorX tree and select New Display from the pop-up menu, as 
 shown in the figure below. 
 

 
 

Creating a New GraphWorX Display File 
 
2. Choose the type of display to create (e.g. with VBA or without VBA), and give the new file a 
 name, as shown in the figure below. Click OK. 
 

 
Naming the New Display File 
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3. The new file appears in the Displays subtree in the right-hand pane of the ProjectWorX console, 
 as shown in the figure below. ProjectWorX automatically launches the new file in GraphWorX.  
 

 
New Display File Added to GraphWorX Display Tree 

 
Specifying a GraphWorX Startup Display File 
The GraphWorX Display tree provides an option to specify a startup display that automatically 
opens when GraphWorX is started from ProcViewTray. To specify a GraphWorX display file as the 
startup display in the ProjectWorX console: 
 
1. Right-click the display file (e.g. "Main Display.gdf") and select Make Startup Display from the 
 pop-up menu, as shown in the figure below. 
 

 
 

Specifying a GraphWorX Startup Display 
 
2. The icon next to the display file changes from the standard GraphWorX icon to a globe icon, as 
 shown in the figure below. The next time GraphWorX is launched from the ProcViewTray, the 
 startup display will automatically open in GraphWorX. 
 

 
Startup Display Indicated in GraphWorX Display Tree 
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GraphWorX Templates 
The Templates subtree component of the GraphWorX tree in the ProjectWorX console, shown in 
the figure below, includes all the GraphWorX template files available for a project. From here you 
can right-click and create new GraphWorX template files or add existing template files to the project. 
 

 
GraphWorX Templates Subtree 

 
Creating a New GraphWorX Template File 
 
To create a new GraphWorX template file in the ProjectWorX console: 
 
1. Right-click Templates in the GraphWorX tree and select New Template from the pop-up 
 menu, as shown in the figure below. 
 

 
 

Creating a New GraphWorX Template File 
 
2. Choose the type of template to create, and give the new file a name, as shown in the figure 
 below. Click OK. 
 

 
Naming the New File 
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3. The new file appears in the Templates subtree in the right-hand pane of the ProjectWorX 
 console, as shown in the figure below. ProjectWorX automatically launches the new file in 
 GraphWorX.  
 

 

New File Added to GraphWorX Templates Subtree 
 
GraphWorX Symbols 
The Symbols subtree component of the GraphWorX tree in the ProjectWorX console, shown in the 
figure below, includes all the GraphWorX Symbol Library files available for a project. From here you 
can right-click and add existing Symbol Library files to the project.  
 
The way ProjectWorX handles Symbol Library files differs slightly from that of other file types. The 
Symbol Library files, which are usually used from within GraphWorX, are by default placed in the 
Smar\ProcessView\Symbols\ directory created when ProcessView is installed, as shown in the 
Reference to column in the figure below. However, it is possible to have Symbols Library files in 
other locations on the hard drive; ProjectWorX simply references the files from that location.  
 

Note 
When unpacking a project, ProjectWorX automatically distinguishes between Symbol Library files 
located in the Smar\ProcessView\Symbols\ folder and Symbol Library files located in other 
directories. Therefore ProjectWorX handles these files with the necessary care, placing them back 
in the proper location and prompting the user before overwriting existing files. 

 

 
GraphWorX Symbols Subtree 
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GraphWorX VBA Wizard 
The VBA Wizard subtree component of the GraphWorX tree in the ProjectWorX console, shown in 
the figure below, allows you to create a new display with a Microsoft Visual Basic for Applications 
(VBA) Wizard.  
 
1. Click on the Create New VBA Wizard icon, as shown in the figure below. 
 

 

GraphWorX VBA Wizard Subtree 
 
2. Give the new file a name, as shown in the figure below, and then click OK. 
 

 
 

Creating a New GraphWorX VBA Display 
 
3. ProjectWorX automatically launches the new display file in GraphWorX, opening the Symbol 
 Library as well. The new VBA file appears in the Displays subtree in the right-hand pane of the 
 ProjectWorX console, as shown in the figure below.  
 

 
 

New VBA Display File Added to GraphWorX Display Tree 
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AlarmWorX Tree 

 
The AlarmWorX tree in the ProjectWorX console, shown in the figure below, manages files for the 
following AlarmWorX components: 
 
• Alarm Container 

• Logger Configurator 
• Server Configurator 
• Multimedia Configurator 
 

 
AlarmWorX Tree in ProjectWorX Console 

 
The Alarm container files are handled with the basic operations to create, add, duplicate, etc. The 
AlarmWorX Logger Configurator, Server Configurator, and Multimedia Configurator are handled a 
bit differently. The Logger and Server support both Microsoft Access (.mdb) databases and 
Microsoft SQL Server (or MSDE) based databases. AlarmWorX Multimedia only supports Microsoft 
SQL Server (or MSDE) databases. 
 

Note 
Configuration files that use Microsoft Access databases cannot be renamed or duplicated in 
ProjectWorX. If you want to rename or duplicate the configuration file, you should do it within the 
appropriate configurator application.  

 
AlarmWorX Container 
The Alarm Container subtree of the AlarmWorX tree in the ProjectWorX console, shown in the 
figure below, includes all the AlarmWorX container files available for a project. From here you can 
right-click and create new files or add existing files to the project.  
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Alarm Container Subtree 

 
Alarm Logger Configurator 
The Alarm Logger Configurator subtree of the AlarmWorX tree in the ProjectWorX console, 
shown in the figure below, includes all the AlarmWorX Logger configuration database files available 
for a project. From here you can right-click and create new configuration databases or add existing 
configuration databases to the project. You can also activate the database. 
 
The Alarm Logger Configurator supports both Microsoft Access (.mdb) databases and Microsoft 
SQL Server (or MSDE) based databases. For more information about SQL databases, please see 
"Adding a SQL Server Configuration Database to a Project." 
 

 
 

Alarm Logger Configurator Subtree 
 
Alarm Server Configurator 
The Alarm Server Configurator subtree of the AlarmWorX tree in the ProjectWorX console, shown 
in the figure below, includes all the AlarmWorX Server configuration database files available for a 
project. From here you can right-click and create new configuration databases or add existing 
configuration databases to the project. You can also activate the database. 
 
The Alarm Server Configurator supports both Microsoft Access (.mdb) databases and Microsoft 
SQL Server (or MSDE) based databases. For more information about SQL databases, please see 
"Adding a SQL Server Configuration Database to a Project."  
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Alarm Server Configurator Subtree 
 
Multimedia Configurator 
The Multimedia Configurator tree in the ProjectWorX console, shown in the figure below, 
manages AlarmWorX Multimedia configuration databases. The Multimedia Configurator uses 
Microsoft SQL Server databases, and it uses Universal Data Link (.udl) files to connect to the 
Microsoft SQL Server databases. These .udl files contain OLE database connection information that 
allows the Configurator to create and manage connections to OLE databases. You can also activate 
the database. 
 

 

Multimedia Configurator Subtree 
 

Note 
For active Microsoft SQL Server configuration databases, information is stored inside the 
ProjectWorX database and is not subject to continuous polling. If the active configuration is 
changed from outside ProjectWorX (e.g. with the MobileHMI Configurator) you will have to refresh 
the view by right-clicking and selecting Refresh from the pop-up menu. This updates ProjectWorX 
with the new database status. 

 
The following conditions apply to SQL Server configuration databases in ProjectWorX: 
 
• ProjectWorX will not accept SQL Server configuration databases whose file names contain 
 spaces because Microsoft SQL Server 2000 is not able to bulk export such databases. 
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• If a SQL configuration has dependent files (e.g. image files, sound files, etc.), these files will be 
 packed along with the project automatically as referenced files. 
• If ProjectWorX is used to perform certain operations on configurations while an instance of the 
 configurator is open, a dialog box will be shown asking the user to close the configurator. 
 ProjectWorX is blocked until the configurator is closed. 
• Difference unpacking of projects will not work for SQL-based configurations. When unpacking 
 SQL configuration files, all SQL configurations will not be overwritten even if the packed project 
 contains newer files of the same name. 
 
Adding a Multimedia Configuration Database 
To add a Multimedia SQL configuration database to a project: 
 
1. Right-click the configuration tree and select Add Configuration, as shown in the figure below. 
 

 

Adding a Multimedia SQL Server Configuration Database 
 
2. In the Add UDL Files dialog box, select a .udl file and click Open to add the configuration 
 database to the current project. 
 
3. The configuration database appears in the configurations subtree in the right-hand pane of the 
 ProjectWorX console. The details view lists the following properties for the configuration 
 database: 
 
• Configuration Database: Name of the database 

• On Server: Name of the SQL Server in which the database was created 

• Status: The status of the database (could be normal, offline, etc) 

• Linked UDL File: The path to the UDL file used to identify the database 
 
4. The new file appears in the right-hand pane of the ProjectWorX console. If you right-click the 
 file, the Create UDL File option is normally grayed out, as shown in the figure below. If the link 
 to the .udl file is ever broken inside the ProjectWorX database, the Create UDL File option will 
 become available and you will be able to create a new .udl file for the configuration. 
 
 

Note 
Deleting a Microsoft SQL Server database configuration file from a project will delete it only from 
the project, not from SQL Server. (The .udl file will not be deleted as well.) 

 
Creating a New Multimedia SQL Configuration Database 
To create a new Multimedia configuration database in the ProjectWorX console: 
 
1. Right-click the Configurations subtree in the Multimedia Configurator tree and select New 
 Configuration from the pop-up menu, as shown in the figure below. 
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Creating a New Multimedia Configuration Database 
 
2. ProjectWorX launches the Multimedia Configuration Database Wizard, which will help you 
 create a new configuration database. 
 

Note 
For complete information about creating and configuring Multimedia databases, please refer to the 
AlarmWorX Multimedia Configurator Help documentation. 

 
Checking the Database Status 
The Check Database Status option is useful for checking the status of all the Microsoft SQL Server 
databases added to the project. ProjectWorX does not poll SQL Server regularly to get the database 
status, so a “Normal” status will always be displayed even if the database is offline. By using the 
check status option, the list of databases will be refreshed and any eventual problem will be 
displayed. 
 
To get the status of a SQL Server database, right-click and select Check Database Status from the 
pop-up menu, as shown in the figure below.  
 

 
Checking the Database Status 

 
The status of the database is indicated as follows: 
 
• Normal: The database is online and ready 
• Missing: The database is no longer on the server. 
• Offline: The database is still on the server but is currently offline. 
• Recovering: The database is recovering.  
• Loading: The database is currently loading and will be available soon. 
• Suspect: The database may have become corrupt. 
• Not Available: An unknown error has occurred and the database is not available. 
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TrendWorX Tree 
The TrendWorX tree in the ProjectWorX console, shown in the figure below, manages files for the 
following TrendWorX components: 
 
• Trend Container 
• Persistent Trending 
• Reporting 
• Logger Configurator 
 

 
 

TrendWorX Tree in ProjectWorX Console 
 
The Trend container, Persistent Trending, and Reporting files are handled with the basic operations 
to create, add, duplicate, etc. The Logger supports both Microsoft Access (.mdb) databases and 
Microsoft SQL Server (or MSDE) based databases. 
 
TrendWorX Container 
The Trend Container subtree of the TrendWorX tree in the ProjectWorX console, shown in the 
figure below, includes all the TrendWorX container files available for a project. From here you can 
right-click and create new files or add existing files to the project.  
 

 
Trend Container Subtree 

 
TrendWorX Persistent Trending 
The Persistent Trending subtree of the TrendWorX tree in the ProjectWorX console, shown in the 
figure below, includes all the TrendWorX Persistent Trending files available for a project. From here 
you can right-click and create new files or add existing files to the project.  
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TrendWorX Persistent Trending Subtree 

 
TrendWorX Reporting 
The Reporting subtree of the TrendWorX tree in the ProjectWorX console, shown in the figure 
below, includes all the TrendWorX Reporting files available for a project. From here you can right-
click and create new files or add existing configuration files to the project.  
 

 
TrendWorX Reporting Subtree 

 
TrendWorX Logger Configurator 
The Logger Configurator subtree of the TrendWorX tree in the ProjectWorX console, shown in the 
figure below, includes all the TrendWorX Logger configuration database files available for a project. 
From here you can right-click and create new configuration databases or add existing configuration 
databases to the project. You can also activate the database. 
 
The TrendWorX Logger Configurator supports both Microsoft Access (.mdb) databases and 
Microsoft SQL Server (or MSDE) based databases. 
 

 
 

TrendWorX Logger Configurator Subtree 
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Activating TrendWorX Logger Configuration Databases 
TrendWorX Logger configuration databases are handled the same as previously explained for 
AlarmWorX configuration databases with the exception that setting a TrendWorX database active 
requires you to select the internal configuration if more than one database is provided. 
 
To activate a TrendWorX Logger configuration database: 
 
1. Right-click the file and select Make Configuration Active from the pop-up menu. 

2. Select the configuration database to activate, as shown in the figure below. Click OK.  

3. The icon next to the configuration file changes from the standard icon to a globe icon to indicate 
 that it is active, as shown in the figure below.  
 

 
Selecting a TrendWorX Database to Activate 

 
DataWorX Tree 

 
The DataWorX tree in the ProjectWorX console, shown in the figure below, includes all the 
DataWorX files available for a project.  
 

 
DataWorX Tree in ProjectWorX Console 
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DataWorX Projects 
In the DataWorX Projects subtree of the DataWorX tree in the ProjectWorX console, you can right-
click and create new files or add existing files to the project. You can also specify a startup project. 
 

 
 

DataWorX Projects Subtree 
 
Specifying a DataWorX Startup Project  
The DataWorX Projects subtree of the DataWorX tree provides an option to specify a startup 
project that automatically opens when DataWorX is launched from ProcViewTray.  
 
To specify a DataWorX project file as the startup project in the ProjectWorX console: 
 
1. Right-click the project file and select Make Project Active from the pop-up menu, as shown in 
 the figure below. 
 

 
Specifying a DataWorX Startup Project 

 
2. The icon next to the project file changes from the standard DataWorX icon to a globe icon, as 
 shown in the figure below. The next time DataWorX is launched from the ProcViewTray, the 
 startup project will automatically open in DataWorX. 
 

 
Startup Project Indicated in DataWorX Projects Tree 
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ScriptWorX Tree 

 
The ScriptWorX tree in the ProjectWorX console, shown in the figure below, manages files for the 
following ScriptWorX components: 
 
• Scripts 
• VBA Files 
 
Although you can view all the files that pertain to a script (i.e. the .swx files as well as the .vba files 
with the same name that automatically created when making a new script), the ScriptWorX (.swx) 
files are the only files that you can really access through the ProjectWorX console. Each .swx file 
has a corresponding .vba file. A .vba file without a .swx file would be of no use in this environment, 
so in ProjectWorX these two file types are always connected to each other. This prevents confusion 
and avoids deleting or creating .vba files not connected to any script (.swx) file.  
 

 
ScriptWorX Tree in ProjectWorX Console 

 
ScriptWorX Scripts 
The Scripts Container subtree of the ScriptWorX tree in the ProjectWorX console, shown in the 
figure below, includes all the ScriptWorX script (*.swx) files available for a project. From here you 
can right-click and create new scripts or add existing scripts to the project.  
 

Note 
Each .swx file has a corresponding .vba file. The .vba files that correspond to .swx files are stored 
in the VBA Files subtree. When you create, rename, delete, or activate a .swx script file, the .vba 
file that corresponds to the .swx file will also be created, renamed, deleted, or activated.  
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Scripts Subtree 
 
Specifying a ScriptWorX Startup Script 
The Scripts subtree of the ScriptWorX tree provides an option to specify a startup script that 
automatically opens when ScriptWorX is started from ProcViewTray. To specify a ScriptWorX file as 
the startup script in the ProjectWorX console: 
 
1. Right-click the script file and select Make Startup Script from the pop-up menu, as shown in 

the figure below. 
 

 

Specifying a ScriptWorX Startup Script 
 
2. The icon next to the project file changes from the standard ScriptWorX icon to a globe icon, as 
 shown in the figure below. The next time ScriptWorX is launched from the ProcViewTray, the 
 startup script will automatically open in ScriptWorX. 
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Startup Project Indicated in Scripts Tree 
 
ScriptWorX VBA Files 
The VBA Files subtree of the ScriptWorX tree in the ProjectWorX console, shown in the figure 
below, contains all VBA scripts that correspond to the ScriptWorX (.swx) script files in the Scripts 
subtree. Although you cannot directly modify the .vba files, any time a change is made to a .swx 
script file, the change is reflected in the .vba file that corresponds to that .swx file. 
 

 

VBA Files Subtree 
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MobileHMI Tree 
 
The MobileHMI tree in the ProjectWorX console, shown in the figure below, manages MobileHMI 
configuration databases. The MobileHMI Configurator uses Microsoft SQL Server databases, and it 
uses Universal Data Link (.udl) files to connect to the Microsoft SQL Server database. These .udl 
files contain OLE database connection information that allows the Configurator to create and 
manage connections to OLE databases.  
 

 

MobileHMI Tree in ProjectWorX Console 
 
MobileHMI Configurations 
The Configurations subtree of the MobileHMI tree in the ProjectWorX console, shown in the figure 
below, includes all the MobileHMI configuration databases available for a project. From here you 
can right-click and create new configurations or add existing configuration databases to the project. 
You can also activate the database 
 

Note 
For active Microsoft SQL Server configuration databases, information is stored inside the 
ProjectWorX database and is not subject to continuous polling. If the active configuration is 
changed from outside ProjectWorX (e.g. with the MobileHMI Configurator) you will have to refresh 
the view by right-clicking and selecting Refresh from the pop-up menu. This updates ProjectWorX 
with the new database status. 

 

 
MobileHMI Configurations Subtree 
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The following conditions apply to SQL Server configuration databases in ProjectWorX: 
 
• ProjectWorX will not accept SQL Server configuration databases whose file names contain 
 spaces because Microsoft SQL Server 2000 is not able to bulk export such databases. 
• If a SQL configuration has dependent files (e.g. image files, sound files, etc.), these files will be 
 packed along with the project automatically as referenced files. 
• If ProjectWorX is used to perform certain operations on configurations while an instance of the 
 configurator is open, a dialog box will be shown asking the user to close the configurator. 
 ProjectWorX is blocked until the configurator is closed. 
• Difference unpacking of projects will not work for SQL-based configurations. When unpacking 
 SQL configuration files, all SQL configurations will not be overwritten even if the packed project 
 contains newer files of the same name. 
 
Adding a MobileHMI Configuration Database 
To add a MobileHMI SQL configuration database to a project: 
 
1. Right-click the configuration tree and select Add Configuration, as shown in the figure below. 
 

 
 

Adding a SQL Server Configuration Database 
 
2. In the Add UDL Files dialog box, select a .udl file and click Open to add the configuration 
 database to the current project. 
 
3. The configuration database appears in the configurations subtree in the right-hand pane of the 
 ProjectWorX console. The details view lists the following properties for the configuration 
 database: 
 
• Configuration Database: Name of the database 

• On Server: Name of the SQL Server in which the database was created 

• Status: The status of the database (could be normal, offline, etc) 

• Linked UDL File: The path to the UDL file used to identify the database 
 
4. The new file appears in the right-hand pane of the ProjectWorX console, as shown in the figure 
 below. If you right-click the file, the Create UDL File option is normally grayed out, as shown in 
 the figure below. If the link to the .udl file is ever broken inside the ProjectWorX database, the 
 Create UDL File option will become available and you will be able to create a new .udl file for 
 the configuration. 
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Configuration File Added 

 
Note 

Deleting a Microsoft SQL Server database configuration file from a project will delete it only from 
the project, not from SQL Server. (The .udl file will not be deleted as well.) 

 
Creating a New MobileHMI SQL Configuration Database 
To create a new MobileHMI configuration database in the ProjectWorX console: 
 
1. Right-click the Configurations subtree in the MobileHMI tree and select New MobileHMI 
 Configuration from the pop-up menu, as shown in the figure below. 
 

 

Creating a New MobileHMI Configuration Database 
 
2. ProjectWorX launches the MobileHMI Configuration Database Wizard, which will help you 
 create a new MobileHMI configuration database. 
 

Note 
For complete information about creating and configuring MobileHMI databases, please refer to the 
MobileHMI Configurator Help documentation. 

 
Checking the Database Status 
The Check Database Status option is useful for checking the status of all the Microsoft SQL Server 
databases added to the project. ProjectWorX does not poll SQL Server regularly to get the database 
status, so a “Normal” status will always be displayed even if the database is offline. By using the 
check status option, the list of databases will be refreshed and any eventual problem will be 
displayed. 
 
To get the status of a SQL Server database, right-click and select Check Database Status from the 
pop-up menu, as shown in the figure below.  
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Checking the Database Status 

 
The status of the database is indicated as follows: 
 
• Normal: The database is online and ready 
• Missing: The database is no longer on the server. 
• Offline: The database is still on the server but is currently offline. 
• Recovering: The database is recovering.  
• Loading: The database is currently loading and will be available soon. 
• Suspect: The database may have become corrupt. 
• Not Available: An unknown error has occurred and the database is not available. 
 

Screen Manager Tree 
 
The Screen Manager tree in the ProjectWorX console, shown in the figure below, manages all the 
Screen Manager layout files for ProcessView projects. The Screen Manager tree allows you to 
specify an automatic startup layout for the machine running the project. ProjectWorX includes eight 
default layout (.pwf) files as templates from which to create new Screen Manager layouts to include 
in projects.  
 

 
Screen Manager Tree in ProjectWorX Console 
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Screen Manager Layout Files 
The Layout Files subtree of the Screen Manager tree in the ProjectWorX console, shown in the 
figure below, includes all the Screen Manager layout (.pwf) files available for a project. From here 
you can right-click and create new files or add existing layout files to the project. You can also 
specify a startup layout. 
 

 
Screen Manager Layout Files Subtree 

 
Creating a New Screen Manager Layout File 
To create a new Screen Manager layout file in the ProjectWorX console: 
 
1. Right-click Layout Files in the Screen Manager tree and select New Layout File from the pop-
 up menu, as shown in the figure below. 
 

 
Creating a New Screen Manager Layout File 
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2. Choose one type of layout to create from the eight layout templates that are provided, as shown 
 in the figure below. Click OK. 
 

 
Selecting a Layout 

 
3. Give the new layout file a name, as shown in the figure below. Click OK. 
 

 
Naming the Layout File 

 
4. The new layout file appears in the Layout Files subtree in the right-hand pane of the 
 ProjectWorX console, as shown in the figure below.  
 

 

New Layout File Added to Screen Manager Tree 
 
5. ProjectWorX automatically launches the new layout file in the Screen Manager, as shown in the 
 figure below. As you can see, all layout files for the project appear in the Screen Manager 
 Command Bar. Now you can modify the layouts as needed in the Screen Manager. 
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Note 

For information about configuring layout files, please refer to the Screen Manager Help 
documentation. 

 

 
Screen Manager Launched With Project Layouts 

 
Specifying a Screen Manager Startup Layout  
The Layout Files subtree of the Screen Manager tree provides an option to specify a startup layout 
that automatically opens when Screen Manager is launched from ProcViewTray. To specify a 
Screen Manager project file as the startup layout in the ProjectWorX console: 
 
1. Right-click the layout file and select Make Startup Layout from the pop-up menu, as shown in 
 the figure below. 
 

 
Specifying a Screen Manager Startup Layout 

 
2. The icon next to the layout file changes from the standard Screen Manager layout icon to a 
 globe icon, as shown in the figure below. The next time Screen Manager is launched from 
 ProcViewTray, the startup layout will automatically open in Screen Manager. 
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Startup Layout Indicated in Layout Files Tree 
 
Launching the Screen Manager  
Once you have added Screen Manager layout files to a project, you can launch the Screen Manager 
from the ProjectWorX console. 
 
1. Select the project tree and choose Runtime Configuration from the Tools menu, as shown in 
 the figure below. 
 

 
Launching the Screen Manager From the Tools Menu 

 
2. ProjectWorX automatically launches the new layout file in the Screen Manager, as shown in the 
 figure below. As you can see, all layout files for the selected project appear in the Screen 
 Manager Command Bar. Now you can modify the layouts as needed in the Screen Manager. 
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Screen Manager Launched 

 
GenBroker Tree 

 
The GenBroker tree in the ProjectWorX console, shown in the figure below, manages GenBroker 
configuration files for each project. GenBroker allows you to specify OPC communication types for 
networks. 
 

 
GenBroker Tree in ProjectWorX Console 
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GenBroker Configurations 
The GenBroker Configurations subtree of the GenBroker tree in the ProjectWorX console, shown 
in the figure below, includes all the GenBroker configuration files available for a project. From here 
you can right-click and create new files or add existing configuration files to the project. You can 
also activate a GenBroker configuration. 
A default OLExpress Communication item is listed in the GenBroker configurations. When no 
GenBroker configuration (.gbc) files are present, the default method of communication is OLExpress 
or COM\DCOM.  
 

 
GenBroker Configurations Subtree 

 
Creating a New GenBroker Configuration  
To create a new GenBroker configuration in the ProjectWorX console: 
 
1. Right-click Configurations in the GenBroker tree and select New GenBroker Configuration 
 from the pop-up menu, as shown in the figure below. 
 

 
 

Creating a New GenBroker Configuration 
 
2. This opens the GenBroker Configurator, as shown in the figure below. Configure GenBroker 
 and then click the Save & Close button. 
 

Note 
For information about configuring GenBroker, please refer to the GenBroker Help documentation. 
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Creating a New GenBroker Configuration 

 
3. Give the new file a name, as shown in the figure below. Click Save. 
 

 
Naming the GenBroker Configuration File 

 
4. The new configuration file appears in the GenBroker Configurations subtree in the right-hand 
 pane of the ProjectWorX console, as shown in the figure below. 
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New GenBroker Configuration File Added to GenBroker Tree 

 
Activating a GenBroker Configuration 
The GenBroker Configurations subtree of the GenBroker tree provides an option to activate a 
GenBroker configuration file that automatically opens when GenBroker is launched from 
ProcViewTray.  
 
To specify a GenBroker configuration file as the active configuration in the ProjectWorX console: 
 
1. Right-click the configuration file and select Make Configuration Active from the pop-up menu, 
 as shown in the figure below. 
 

 
 

Activating a GenBroker Configuration File 
 
2. The icon next to the project file changes from the standard GenBroker icon to a globe icon, as 
 shown in the figure below. The next time GenBroker is launched from the ProcViewTray, the 
 active configuration automatically opens in the GenBroker Configurator. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



ProjectWorX 
 

3.39 

 

 

Activated GenBroker Configuration File Indicated in GenBroker Tree  

 
ReportWorX.NET Tree 

 
The ReportWorX.NET tree in the ProjectWorX console, shown in the figure below, manages 
ReportWorX configuration databases. ReportWorX uses Microsoft SQL Server databases, and it 
uses Universal Data Link (.udl) files to connect to the Microsoft SQL Server database. These .udl 
files contain OLE database connection information that allows the Configurator to create and 
manage connections to OLE databases.  
 

 
ReportWorX.NET Tree in ProjectWorX Console 

 
ReportWorX.NET Configurations 
The Configurations subtree of the MobileHMI tree in the ProjectWorX console, shown in the figure 
below, includes all the MobileHMI configuration databases available for a project. From here you 
can right-click and create new configurations or add existing configuration databases to the project. 
You can also activate the database.  



Managing Application Files 
 

3.40 

 
Note 

ProjectWorX database and is not subject to continuous polling. If the active configuration is 
changed from outside ProjectWorX (e.g. with the MobileHMI Configurator) you will have to refresh 
the view by right-clicking and selecting Refresh from the pop-up menu. This updates ProjectWorX 
with the new database status. 

 

 
ReportWorX.NET Configurations Subtree 

 
The following conditions apply to SQL Server configuration databases in ProjectWorX: 
 
• ProjectWorX will not accept SQL Server configuration databases whose file names contain 
 spaces because Microsoft SQL Server 2000 is not able to bulk export such databases. 
• If a SQL configuration has dependent files (e.g. image files, sound files, etc.), these files will be 
 packed along with the project automatically as referenced files. 
• If ProjectWorX is used to perform certain operations on configurations while an instance of the 
 configurator is open, a dialog box will be shown asking the user to close the configurator. 
 ProjectWorX is blocked until the configurator is closed. 
• Difference unpacking of projects will not work for SQL-based configurations. When unpacking 
 SQL configuration files, all SQL configurations will not be overwritten even if the packed project 
 contains newer files of the same name. 
 
Adding a ReportWorX Configuration Database 
To add a ReportWorX SQL configuration database to a project: 
 
1. Right-click the configuration tree and select Add Configuration, as shown in the figure below. 
 

 
Adding a SQL Server Configuration Database 

 
2. In the Add UDL Files dialog box, select a .udl file and click Open to add the configuration 
 database to the current project. 
 
3. The configuration database appears in the configurations subtree in the right-hand pane of the 
 ProjectWorX console. The details view lists the following properties for the configuration 
 database: 
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• Configuration Database: Name of the database 

• On Server: Name of the SQL Server in which the database was created 

• Status: The status of the database (could be normal, offline, etc) 

• Linked UDL File: The path to the UDL file used to identify the database 
 
4. The new file appears in the right-hand pane of the ProjectWorX console, as shown in the figure 
 below. If you right-click the file, the Create UDL File option is normally grayed out. If the link to 
 the .udl file is ever broken inside the ProjectWorX database, the Create UDL File option will 
 become available and you will be able to create a new .udl file for the configuration. 
 

Note 
Deleting a Microsoft SQL Server database configuration file from a project will delete it only from 
the project, not from SQL Server. (The .udl file will not be deleted as well.) 

 
Creating a New ReportWorX SQL Configuration Database 
To create a new ReportWorX configuration database in the ProjectWorX console: 
 
1. Right-click the Configurations subtree and select New Configuration from the pop-up menu, 
 as shown in the figure below. 
 

 
Creating a New ReportWorX Configuration Database 

 
2. ProjectWorX launches the ReportWorX Configurator, which will help you create a new 

configuration database. 
 
Checking the Database Status 
The Check Database Status option is useful for checking the status of all the Microsoft SQL Server 
databases added to the project. ProjectWorX does not poll SQL Server regularly to get the database 
status, so a “Normal” status will always be displayed even if the database is offline. By using the 
check status option, the list of databases will be refreshed and any eventual problem will be 
displayed. 
 
To get the status of a SQL Server database, right-click and select Check Database Status from the 
pop-up menu, as shown in the figure below.  
 

 
Checking the Database Status 

 
The status of the database is indicated as follows: 
 

• Normal: The database is online and ready 

• Missing: The database is no longer on the server. 
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• Offline: The database is still on the server but is currently offline. 

• Recovering: The database is recovering.  

• Loading: The database is currently loading and will be available soon. 

• Suspect: The database may have become corrupt. 

• Not Available: An unknown error has occurred and the database is not available. 

 
WebHMI Tree  

 
The WebHMI tree in the ProjectWorX console, shown in the figure below, manages Web publishing 
for each project. From here you can right-click and publish files to a Web server. The WebHMI tree 
includes three major categories of files for WebHMI users: 
 
• GraphWorX-Based HTML 
• Local HTML Files 
• Published Documents 
 
For more information about these categories, please see Chapter 6. 
 

 
WebHMI Tree in ProjectWorX Console 

 
ProcessView Tray Tree 

 
The ProcessView Tray tree of the ProjectWorX console, shown in the figure below, is a snap-in 
that includes all the capabilities of the ProcessView Tray application. When the ProcessView Tray 
tree is selected, a list of the  ProcessView applications on the machine is provided, as shown in the 
figure below. From this list you can check to see whether a server or an application is running and 
browse their settings. For more information about ProcessView Tray, please see Chapter 6. 
 

Note 
The ProcessView Tray tree shows data for the active project only.  
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ProcViewTray Tree in ProjectWorX Console 

 
Language Aliasing Tree  

 
The Language Aliasing tree in the ProjectWorX console, shown in the figure below, manages 
language configuration databases for each project. From here you can right-click and create new 
configurations or add existing configuration databases to the project. You can also activate the 
database. 
 

 
 

Language Aliasing Tree in ProjectWorX Console 
 
Language Configurations 
The Configurator subtree of the Language Aliasing tree in the ProjectWorX console, shown in the 
figure below, includes all the Language Configurator databases available for a project. From here 
you can right-click and create new databases or add existing configuration databases to the project.   
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Language Aliasing Configuration Subtree 

 
Creating a New Language Configuration  
To create a new language configuration in the ProjectWorX console: 
 
1. Right-click Configurator in the Language Aliasing tree and select New Configuration from 
 the pop-up menu, as shown in the figure below. 
 

 
Creating a New Language Configuration 

 
2. Give the new file a name, as shown in the figure below. Click OK. 
 

 
Naming the New Configuration Database 

 
3. The new file appears in the Language Configurator subtree in the right-hand pane of the 
 ProjectWorX console, as shown in the figure below. 
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New Language Database Added to Language Configurator Tree 

 

Global Aliasing Tree 
 
The Global Aliasing tree in the ProjectWorX console, shown in the figure below, includes all the 
Global Alias Configurator databases available for a project. From here you can right-click and create 
new databases or add existing configuration databases to the project. You can also activate the 
database.  
 

 
Global Aliasing Tree 

 
Global Aliasing Configurations 
The Configurator subtree of the Global Aliasing tree in the ProjectWorX console, shown in the 
figure below, includes all the Global Aliasing Configurator databases available for a project. From 
here you can right-click and create new databases or add existing configuration databases to the 
project.  
 

 
Global Aliasing Configurator Subtree 

 
Creating a New Global Aliasing Configuration  
To create a new global aliasing configuration in the ProjectWorX console: 
 
1. Right-click Configurations in the Global Aliasing tree and select New Configuration from the 
 pop-up menu, as shown in the figure below. 
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Creating a New Global Aliasing Configuration 
 
2. Give the new file a name, as shown in the figure below. Click OK. 
 

 
Naming the New Configuration Database 

 
3. The new file appears in the Global Aliasing Configurator subtree in the right-hand pane of the 
 ProjectWorX console, as shown in the figure below. 
 

 
New Database Added to Global Aliasing Configurator Tree 

 
My Files Tree 

 
The My Files tree in the ProjectWorX console, shown in the figure below, allows you to add any 
type of file you wish to the project. The only difference here is that you will not see the packing, 
unpacking, or Web publishing log files.  
To add a file:  
 
1. Right-click the My Files tree and select Add File from the pop-up menu, as shown in the figure 
 below.  
 
2. Choose a file to add, and then click Open. The new file appears in the right-hand pane of the 
 ProjectWorX console. 
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My Files Tree 

 
Microsoft Office Tree 

 
You have the option of displaying the (third-party) Microsoft (MS) Office tree in the ProjectWorX 
console. This tree, shown in the figure below, manages files for Microsoft Word, Microsoft 
PowerPoint, Microsoft Excel, and Microsoft Access, is hidden by default. When enabled in the 
Show/Hide Applications dialog box, the MS Office tree is displayed under the project 
Applications tree. The MS Office tree is similar to the other application trees in that you can create, 
add, copy, delete, and open files. You can also generate reports.  
 

Note 
You can also perform global searches in Microsoft Excel spreadsheets. For more information, 
please see Chapter 2. 

 

 
Microsoft Office Tree 

 
To display the MS Office tree: 
 
1. Right-click the on the Applications tree and select Customize from the pop-up menu, as 
 shown in the figure below. 
 
2. This opens the Show/Hide Applications dialog box, as shown in the figure below. Check the 
 MS Office in the dialog box. Click OK. 
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OPC Servers Tree 

 
The OPC Servers tree for each project, shown in the figure below, allows you to create and manage 
OPC server configurations. Each time you create a new OPC server configuration inside a project in 
the OPC Servers tree, the new file is saved to the project folder in the "Bin" directory. If you add an 
existing configuration file, you have the option of copying the file to the project folder or running the 
file from its current location. 
 

Note 
ProjectWorX currently supports configuration for the Simulator OPC Server only, which is installed 
with ProcessView. All other OPC servers (e.g. DataStore OPC Server, etc.) must be installed 
before you can configure them through ProjectWorX. 

 

 
Project OPC Servers 

 
OPC Simulator Tree  
The OPC Simulator subtree component of the OPC Servers tree in the ProjectWorX console, 
shown in the figure below, includes all the Simulator OPC server configuration files available for a 
project. From here you can right-click and add existing configuration files to the project.  
 

 
OPC Simulator Subtree 
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Creating a New Simulator OPC Server Configuration File 
To create a new Simulator OPC Server configuration file in the ProjectWorX console: 
 
1. Right-click OPC Simulator in the OPC Servers tree and select New OPC Simulator 

configuration from the pop-up menu, as shown in the figure below. 
 

 
Creating a New OPC Simulator Configuration File 

 
2. Give the new file a name, as shown in the figure below. Click OK. 
 

 
Naming the New File 

 
3. The new file appears in the OPC Simulator subtree in the right-hand pane of the ProjectWorX 

console, as shown in the figure below. ProjectWorX automatically launches the new file in 
Simulator OPC Server Configurator. 

 

 
New File Added to OPC Simulator Tree 

 
Activating a Simulator OPC Server Configuration 
The OPC Simulator in the OPC Servers tree provides an option to activate a Simulator OPC 
Server configuration file: 
 
1. Right-click the configuration file and select Activate Configuration from the pop-up menu, as 

shown in the figure below. 
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Activating a Simulator OPC Server Configuration 

 
2. ProjectWorX automatically launches the new file in Simulator OPC Server Configurator. 
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ProcessView Tray, System Tools and 
Security 
 

ProcessView Tray 
 
The ProcessView Tray tree of the ProjectWorX console, shown in the figure below, includes all the 
capabilities of the ProcessView ProcessView Tray application. When the ProcessView Tray tree is 
selected, a list of the ProcessView applications on the machine is provided, as shown in the figure 
below. From this list you can check to see whether a server or an application is running and browse 
their settings.  
 

Note 
The ProcessView Tray tree shows data for the active project only.  

 

 
ProcessView Tray Tree in ProjectWorX Console 

 
Starting and Stopping Applications Using ProcessView Tray 

 
ProcessView Tray provides a way to either manually or automatically start and/or stop applications 
within ProcessView. In the ProcessView Tray tree for the active project in the ProjectWorX console, 
you can specify which applications and servers to start and stop. You can also set up applications to 
run auto start upon Windows startup, setting their timing and launching position parameters.  
 

Note 
An application can be detected as running only if the application is launched through the 
ProcessView Tray. 

 
Starting Applications From ProcessView Tray 
To launch an application from ProcessView Tray: 
 
1. Right-click the application in the details view and select All Tasks > Start from the pop-up 
 menu, as shown in the figure below. 
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Starting an Application in ProcessView Tray 

 
2. The application is launched and the Status changes to Running, as shown in the figure below. 
 

 
 

Application Running in ProcessView Tray 
 
Stopping Applications From ProcessView Tray 
To shut down a running application from ProcessView Tray: 
 
1. Right-click the application in the details view and select All Tasks > Stop from the pop-up 
 menu, as shown in the figure below. 
 

 
Stopping an Application in ProcessView Tray 

 
2. The application is stopped, and the status changes to Not Running, as shown in the figure 
 below. 
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Application Stopped in ProcessView Tray 

 
Setting Application Properties From ProcessView Tray 

 
From the ProcessView Tray tree of the ProjectWorX console, you can view application properties for 
both clients and servers. Any changes that you make to the application properties settings are 
reflected in the details list of the ProjectWorX ProcessView Tray tree. To change the properties for 
an application, right-click the application in the details view and select Properties from the pop-up 
menu, as shown in the figure below. 
 

 
 

Viewing Application Properties From the ProcesView Tray Tree 
 
The Properties dialog box opens, as shown in the figure below. The properties indicate the current 
status of the application (i.e. Running or Not Running).  
 
The server properties are slightly different from the client properties. The server properties have 
Run as a Service and Run at Startup options, while client properties instead have a Command 
Line feature that indicates the designated startup file for the application (as specified in the active 
project). 
 
ProcessView Tray enables you register and run servers as an NT service. To convert a server to an 
NT service, check the Run as a Service check box, as shown in the figure below. Once an 
application is converted to an NT service, checking the Run at Startup check box makes it an 
automatic service so that it will automatically start every time the computer is restarted. 
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Server Properties 

 
The Auto Start and Auto Stop options enable a ProcessView system application to be opened and 
shut down automatically and in an orderly fashion. Selecting these items puts the application in a 
management list with other applications that are auto started and auto stopped. The order in which 
these applications are started or stopped is determined by the relative start and stop positions 
specified in the application properties. Both the server properties and client properties dialogs have 
the following ProcessView Tray application startup and shutdown options, which set the start and 
stop parameters for the application: 
 
• Auto Start: When checked, ProcessView Tray automatically launches the application upon 
 ProcessView Tray startup. 
• Startup Position: Specifies the order in which the application will be started (if multiple 
 applications are auto started). For example, if both GraphWorX and AlarmWorX are to be auto 
 started but you want GraphWorX to start before AlarmWorX starts, set the startup position for 
 GraphWorX to "1" and the startup position for AlarmWorX to "2." 
• Startup Delay: Sets the delay (in seconds) before the application is launched. 
• Auto Stop: When checked, ProcessView Tray automatically stops the application upon 
 ProcessView Tray shutdown. 
• Shutdown Position: Specifies the order in which the application will be shut down (if multiple 
 applications are auto stopped). 
• Shutdown Delay: Sets the delay (in seconds) before the application is stopped. 
 
Click the Apply button to set the parameters you have selected in the application properties. 
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Client Properties 

 
Viewing Application Parameters in ProcessView Tray 
The parameters that are set the application properties are displayed in the details view of the 
ProcessView Tray, as shown in the figure below. The column headers indicate the following 
properties:  
 
• Application: Name of the application. 
• Application ID: Name of the application's executable file. 
• Status: Current application status (i.e. Running or Not Running). 
• Start With Project: States whether auto start is enabled for the application (i.e. Yes or No). 
• Start Position: Specifies the order in which the application will be started (if multiple 
 applications are auto started). 
• Start Delay: Delay (in seconds) before the application is launched. 
• Stop With Project: States whether auto stop is enabled for the application (i.e. Yes or No). 
• Stop Position: Specifies the order in which the application will be shut down (if multiple 
 applications are auto stopped). 
• Stop Delay: Delay (in seconds) before the application is stopped. 
• Run as Service: States whether a server is run as an NT service (i.e. Yes or No). 
• Service Autorun: States whether a server run as an NT service will automatically start every 
 time the computer is restarted (i.e. Yes or No). 
• Command Line: Indicates the designated startup file/database for the application (as specified 
 in the active project). 
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Application Parameters in ProcessView Tray Tree 

 
System Tools  

 
The System Tools tree of the ProjectWorX console is a snap-in from which you can conveniently 
launch all of the available ProcessView tools, as shown in the figure below. To launch a tool, 
double-click the tool in the right-hand pane of the ProjectWorX console. The tool's executable file is 
opened. 
 

 

System Tools Snap-in in ProjectWorX Console 
 

Security Administration 
 
Each of the ProjectWorX snap-ins has a toolbar button that provides direct access to the SMAR 
Security Server Login Utility, as shown in the figure below. You can also access the Security Login 
Utility from the System Tools snap-in. 
 

   
 

Security Login Button in Snap-in Toolbars 
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Clicking the Security Login button on the toolbar launches the security login screen, as shown in 
the figure below. 
 

 
Logging Into the Security Server 

 
Logging into the Security Server provides the necessary rights to handle all the project operations 
with a proper security level. The actual access level is always shown in the bottom right-hand corner 
of the ProjectWorX console status bar, as shown in the figure below. There are three possible 
access levels: 
 
• Full Access 
• Read Only 
• <no rights> 
 

 
Security Status Shown in ProjectWorX Status Bar 

 
Upon startup, ProjectWorX checks for the default security level of the machine. It also checks the 
ProcessView security settings using the DEFAULT Application Action user association list in the 
Security Configurator to determine the startup access level to ProjectWorX. The security access 
restrictions affect all the elements in ProjectWorX, so certain ProjectWorX elements are restricted 
(e.g. menus are grayed out, options are unavailable, etc.) if a user has read-only rights or no rights 
at all. 
 

Note 
For complete information about ProcessView security administration, please refer to the Security 
Configurator and Security Login Help documentation. 
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Backing up Projects to Visual SourceSafe 
 

Visual SourceSafe Integration 
 

ProjectWorX provides a feature that allows you to back up projects and application files to Microsoft® 
Visual SourceSafe. Microsoft Visual SourceSafe does not need to be installed on the same node as 
ProjectWorX. Typically, SourceSafe is installed on a network server, and the clients that check files in 
and check files out browse over the network to the "SrcSafe.ini" file on the remote (server) node. 

 
Note 

Please refer to the Microsoft Visual Studio and Visual SourceSafe help documentation for 
instructions on how to install and use Visual SourceSafe. 

 
Setting up a User Profile in Visual SourceSafe 
Before you can login to Visual SourceSafe through ProjectWorX and back up your projects, you 
must configure a user profile in Visual SourceSafe: 
 
1. From the Windows Start menu, select Programs > Microsoft Visual Studio > Microsoft 
 Visual SourceSafe > Visual SourceSafe Administrator, as shown in the figure below. 
 

 
 

Starting Microsoft Visual SourceSafe 
 
2. In the Visual SourceSafe Login, enter an administrator password, as shown in the figure 
 below. Click OK. 
 

 
Visual SourceSafe Login 

 
3. The Visual SourceSafe Administrator opens showing the user profiles, as shown in the figure 
 below. 
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Visual SourceSafe Administrator 

 
4. To add a new user profile, select Add User from the Users menu, as shown in the figure below. 
 

 
Adding a New User Profile 

 
5. Enter a name and password for the new user, as shown in the figure below. Click OK. 

 

 
Entering a User Name and Password for the New User 



ProjectWorX 

5.3 

 
6. The new user is added to the Visual SourceSafe Administrator, as shown in the figure 
 below. 
 

 
New User Added to Visual SourceSafe Administrator 

 
Logging Into Visual SourceSafe From ProjectWorX 

 
Once you have configured a user login profile in the Visual SourceSafe Administrator, you can back 
up your ProjectWorX projects to Visual SourceSafe. 
 
1. In the ProjectWorX console, select Login to SourceSafe from the Tools menu, as shown in the 
 figure below. 
 

 
Logging Into Visual SourceSafe Through the ProjectWorX Console 

 
2. Enter your Visual SourceSafe user name and password (specified in the Visual SourceSafe 
 Administrator settings), as shown in the figure below. The .ini file is the SourceSafe 
 initialization file found on the node where SourceSafe is installed.  Select an .ini file by 
 clicking the ... button in the Visual SourceSafe Login dialog box and browsing (locally or over 
 a network) for a file. Click OK to login to Visual SourceSafe. If any of these parameters is 
 incorrect, you will be notified accordingly. 
 

Note 
It is recommended that you use the default .ini file provided by Visual SourceSafe. 
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Visual SourceSafe Login in ProjectWorX 

 
3. Once you login, the Source Control menu becomes available on the Action menu of the 
 ProjectWorX console when a project is selected, as shown in the figure below. 
 

 
 

Source Control Menu Activated in ProjectWorX 
 

Source Control Options 
 
The Source Control menu on the Action menu of the ProjectWorX console provides options for 
backing up files to and retrieving files from the Visual SourceSafe database, as shown in the figure 
below.  
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Source Control Menu Activated in ProjectWorX 

 
The following general options are available:  
 

• Add to Source Control: Makes a read-only copy of a file and backs up the file to the Visual 
 SourceSafe database. 

• Remove from Source Control: Removes or deletes the file from the Visual SourceSafe 
 database. 

• Check in: Backs up the latest version of a file to the Visual SourceSafe database. 

• Check out: Retrieves a version of a file from the Visual SourceSafe database. 

• Undo check-out: Nullifies the check-out of a file from the Visual SourceSafe database. 

• Get latest version: Retrieves the most recent version of a file from the Visual SourceSafe 
 database. 

• History: Provides information about when a file was created and last modified as well as any 
 comments or labels associated with each version of the file. Also specifies which version of the 
 file to retrieve from the Visual SourceSafe database. 

The Source Control options in ProjectWorX can be applied to the following denominations of files: 

• Individual files  
• Groups of application files 
• Entire projects 
 

Note 
You must be logged into Visual SourceSafe in order to access the Source Control options. If you 
are not logged in, the Source Control menu is not available in the ProjectWorX console. 

 
Comments for Source Control Actions 
For each Source Control action (e.g. add, check-out, check-in, etc.), ProjectWorX prompts you to 
enter a comment to document the action because the Prompt for Comments option is selected by 
default in the Tools menu of the ProjectWorX console, as shown in the figure below. This way you 
have a record of each action and a detailed history for each file version in the Visual SourceSafe 
database. 
 

Note 
You can disable the Prompt for Comments option on the Tools menu, but this is not 
recommended. 
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Prompt for Comments Option Enabled 
 
ProjectWorX provides a generic comment for each action, such as the example comment shown in 
the figure below. You can use this comment or type a new comment to associate with the file. 
 

 
Adding a Comment for Source Control Actions 

 
Adding Files to Visual SourceSafe 

 
The Add to Source Control option on the Source Control menu allows you to add individual files, 
groups of application files, and entire projects in the ProjectWorX console to the Visual SourceSafe 
database. 
 
When you add a file to source control, the icon for the file will change.  An item under source control 
that is checked in contains a yellow box in the lower-left corner.  An item that is under source control 
and checked out contains a checkmark in the yellow box, as shown below. 
 

 - Not under source control 
  - Checked into SourceSafe 
  - Checked out of SourceSafe 

 
Adding Individual Files to Visual SourceSafe 
To add a single file to Visual SourceSafe from ProjectWorX: 
 
1. Right-click the file in the ProjectWorX console and select Source Control > Add to Source 
 Control, as shown in the figure below.  
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Adding a File to Visual SourceSafe 

 
2. Type a comment to document the addition of the file to Visual SourceSafe, as shown in the 
 figure below, and then click OK. 
 

 
Adding a Comment 

 
3. Once the file is added to the Visual SourceSafe database, the icon next to the file name is 
 marked with a yellow tag, as shown in the figure below. The file automatically becomes read-
 only (it cannot be modified). 
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File Added to Visual SourceSafe 
 
Adding Groups of Application Files to SourceSafe 
Just as you can add individual files to SourceSafe, ProjectWorX also allows you to add groups of 
application files to SourceSafe: 
 
1. Right-click the file group (e.g. GraphWorX Displays) in the Applications tree in the ProjectWorX 
 console and select Source Control > Add All to Source Control, as shown in the figure 
 below.  
 

 
Adding a Group of Files to SourceSafe 

 
2. Type a comment to document the addition of the file group to Visual SourceSafe, as shown in 
 the figure below, and then click OK. 
 

 
Adding a Comment 
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3. The entire group of files is added to the Visual SourceSafe database. The icon next to each file 
 name is marked with a yellow tag, as shown in the figure below. The files automatically become 
 read-only (they cannot be modified). 
 

 
 

Group of Files Added to Visual SourceSafe 
 
Adding Projects to Visual SourceSafe 
Just as you can add individual files and groups of files to Visual SourceSafe, ProjectWorX also 
allows you to add all the files in a project to Visual SourceSafe at once: 
 
1. Right-click the project (e.g. Power Plant) in the Applications tree in the ProjectWorX console 
 and select Source Control > Add All to Source Control, as shown in the figure below.  
 

 
 

Adding a Project to SourceSafe 
 
2. Type a comment to document the addition of the project to Visual SourceSafe, as shown in the 
 figure below, and then click OK. 
 

 
Adding a Comment 
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3. All files in the project are added to the Visual SourceSafe database. The icon next to each file 
 name is marked with a yellow tag, as shown in the figure below. The files automatically become 
 read-only (they cannot be modified). 
 

 
All Project Files Added to Visual SourceSafe 

 
Viewing Files Added to Visual SourceSafe 
To view your files in Visual SourceSafe: 
 
1. From the Windows Start menu, select Programs > Microsoft Visual Studio > Microsoft 
 Visual SourceSafe > Microsoft Visual SourceSafe, as shown in the figure below. 
 

 
 

Opening Microsoft Visual SourceSafe 
 
2. In the Visual SourceSafe Login, enter a user name and password, as shown in the figure 
 below. Click OK. 
 

 

Visual SourceSafe Login 
 
3. The Visual SourceSafe Explorer opens, as shown in the figure below. As you can see, the 
 project directory structure of the ProjectWorX console is preserved in the Visual SourceSafe 
 Explorer so you can easily locate the files you have added to Visual SourceSafe. 
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Viewing Files in the Visual SourceSafe Explorer 
 

Checking Files out of Visual SourceSafe 
 
Once a file is added to the Visual SourceSafe, the file becomes read-only. In order to modify the file, 
you must check it out of Visual SourceSafe. Checking out a file does not remove the file from the 
Visual SourceSafe database. Instead ProjectWorX retrieves a version of the file and removes the 
read-only status from the file. You can check out both individual files and batches of files. 
 
Checking Individual Files out of Visual SourceSafe 
To check a single file out of Visual SourceSafe: 
 
1. Right-click the file in the ProjectWorX console and select Source Control > Check Out, as 
 shown in the figure below.  
 

 
Checking a File out of SourceSafe 
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2. Type a comment to document the file check-out, as shown in the figure below, and then click 
 OK. 
 

 
Adding a Comment Upon File Check-out 

 
3. Once the file is checked out of the Visual SourceSafe database, a red check mark is appears 
 on the icon next to the file name, as shown in the figure below. The file's read-only status is 
 temporarily removed so it can be modified. The read-only status is not restored until the file is 
 checked back into the Visual SourceSafe database. 
 

 
File Checked out of Visual SourceSafe 

 
Checking Batches of Files out of Visual SourceSafe 
To check a batch of files (i.e. files for an entire group or project) out of Visual SourceSafe: 
 
1. Right-click the group or project in the ProjectWorX console and select Source Control > Batch 
 Check Out, as shown in the figure below.  
 

 
Checking a Batch of Files out of SourceSafe 
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2. Type a comment to document the batch check-out, as shown in the figure below, and then click 
 OK. 
 

 
Adding a Comment Upon Batch Check-out 

 
3. Once files are checked out of the Visual SourceSafe database, a red check mark is appears on 
 the icon next to each file name, as shown in the figure below. Each file's read-only status is 
 temporarily removed so it can be modified. The read-only status is not restored until the file is 
 checked back into the Visual SourceSafe database. 
 

 
 

Batch of Files Checked out of Visual SourceSafe 
 
Undoing File Check Out From SourceSafe 
If you check a file out of SourceSafe and later decide you do not want to check it out, you can nullify 
the check out by right-clicking the file in the ProjectWorX console and selecting Source Control > 
Undo Check Out, as shown in the figure below.  
 

Note 
Select Batch Undo Check Out to nullify check-out for a group of files. 

 

 
Undoing File Check out From SourceSafe 
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Checking Files Into Visual SourceSafe 

 
Once a file is checked out of Visual SourceSafe, the read-only status is temporarily removed so it 
can be modified. To back up the recent changes to the file and to restore the file's read-only status, 
you must check the file back into the Visual SourceSafe. You can check in both individual files and 
batches of files. 
 
Checking Individual Files Into Visual SourceSafe 
To check a single file into Visual SourceSafe: 
 
1. Right-click the file in the ProjectWorX console and select Source Control > Check In, as 
 shown in the figure below.  
 

 
Checking a File Into SourceSafe 

 
2. Type a comment to document the file check-in, as shown in the figure below, and then click OK. 
 

 
Adding a Comment Upon File Check-in 

 
3. Once the file is checked back into the Visual SourceSafe database, the red check mark is 
 removed from the icon next to the file name, as shown in the figure below. The file's read-only 
 status is restored so it cannot be modified.  
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Project File Checked Into Visual SourceSafe 

 
Checking Batches of Files Into Visual SourceSafe 
To check a batch of files (i.e. files for an entire group or project) into Visual SourceSafe: 
 
1. Right-click the group or project in the ProjectWorX console and select Source Control > Batch 
 Check In, as shown in the figure below.  
 

 
Checking a Batch of Files Into SourceSafe 

 
2. Type a comment to document the batch check-in, as shown in the figure below, and then click 
 OK. 
 

 
Adding a Comment Upon File Check-in 
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3. Once the files are checked back into the Visual SourceSafe database, the red check mark is 
 removed from the icon next to each file name, as shown in the figure below. Each file's read-
 only status is restored so it cannot be modified.  
 

 
Project File Checked Into Visual SourceSafe 

 
Retrieving File Versions From Visual SourceSafe 

 
One of the major advantages of using Visual SourceSafe to back up your application files in 
ProjectWorX is that Visual SourceSafe database maintains multiple versions of the same file. Every 
version of a file has a version number with a date and time as well as any relevant comments or 
labels. Each time the file is modified, resaved, and then checked back into SourceSafe, the previous 
version of the file is not overwritten. Instead each version is stored separately so you can refer to 
previous versions of the file as needed.  
 
Two Source Control options in the ProjectWorX console allow you to specify which version of a file 
to retrieve from the Visual SourceSafe database: 
 
• Get latest version: Retrieves the most recent version of a file from the Visual SourceSafe 
 database. 
• History: Provides information about when a file was created and last modified as well as any 
 comments associated with each version of the file. Also specifies which version of the file to 
 retrieve from the Visual SourceSafe database. 
 
Getting the Latest File Version 
To retrieve the most recent version of a file from the Visual SourceSafe database:  
 
1. Right-click the group or project in the ProjectWorX console and select Source Control > Get 
 Latest Version, as shown in the figure below.  
 

Note 
To get the latest version for a batch of files, select Batch Get Latest Version from the Source 
Control menu. 
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Getting the Latest Version of a File From SourceSafe 

 
2. As you can see in the figure below, the latest version is retrieved and the date of the file is 
 refreshed. 
 

Note 
Retrieving the latest file version is not the same as checking a file out of the Visual SourceSafe 
database. When the latest version of the file is retrieved, the file maintains its read-only status. 

 

 
Latest Version of File Retrieved From SourceSafe 

 
Viewing File History 
The History option in the ProjectWorX Source Control provides information about when a file was 
created and last modified as well as any comments or labels associated with each version of the file. 
To review the history for a file: 
 
1. Right-click the file in the ProjectWorX console and select Source Control > History, as shown 
 in the figure below.  
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Viewing the History for a File 

 
2. The history dialog box opens, as shown in the figure below, showing the following information 
 about the file: 
 
• Version Number: Lists all versions of the file from oldest to most recent (i.e. version "1" is the 
 oldest). To view the history of a different version of the file, click the up and down arrows. To 
 retrieve the currently selected version, click the Get button. 
• User: Name of the user currently logged into Visual SourceSafe. 
• Date: Shows the date and time of the currently selected file version. 
• Action: Documents the last type of modification to the file version. 
• Comment: Shows any comments entered for each version's (e.g. check-in, check-out, etc.) 
• Label: Shows a label for each version (if applicable).  
 

Note 
To make a version easier to identify, you can assign it a label in Visual SourceSafe (any string up 
to 31 characters) and refer to the version by its label. Each time the Label command is used in 
Visual SourceSafe, a new version of the selected file is created, and the label is associated with 
that version. 

 
• Label Comment: Shows any additional comments added while creating a file version label in 
 Visual SourceSafe. 
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Viewing File History and Version Information 

 
Removing Files from Visual SourceSafe 

 
To remove a file from Visual SourceSafe: 
 
1. Right-click the file in the ProjectWorX console and select Source Control > Remove From 
 Source Control, as shown in the figure below.  
 

 
Removing a File From SourceSafe 
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2. A message box appears asking you if you want to remove the file. If Remove SourceSafe 
 Copy is checked, the file is removed from the Visual SourceSafe Explorer but a copy of the file 
 remains in the Visual SourceSafe database. If Destroy SourceSafe copy permanently is 
 checked, file is permanently deleted from the SourceSafe database and cannot be retrieved. 
 Click Yes to proceed with the file removal. 
 

 
Confirming File Removal 

 
 
3. Once the file is removed from Visual SourceSafe, the yellow tag is removed from the file icon in 
 the ProjectWorX console, as shown in the figure below, and the file's read-only status is 
 removed. 
  

 
File Removed From Visual SourceSafe 
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Web Publishing in ProjectWorX 
 

Using the Web Publishing Wizard 
 
The Web Publishing Wizard can be accessed through ProjectWorX console, allowing you to easily 
export/publish one or more GraphWorX display files within a project to a Web server. As shown in 
the figure below, the Applications/GraphWorX/Displays tree of each project includes an option to 
publish a single display or multiple displays in the project.  
 

 
Publishing GraphWorX Displays From the ProjectWorX Console 

 
The WebHMI tree under the Applications tree for each project in the ProjectWorX console, shown 
in the figure below, manages Web publishing for the entire project. From here you can right-click 
and publish HTML files to a Web server. The WebHMI tree includes the following three categories: 
 
• GraphWorX-Based HTML 
• Local HTML Files 
• Published Documents 
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WebHMI Tree in ProjectWorX Console 

 
GraphWorX-Based HTML 
The GraphWorX-Based HTML subtree of the WebHMI tree, shown in the figure below, contains 
HTML files generated from exported GraphWorX displays. These HTML files have embedded code 
for accommodating a GraphWorX Viewer ActiveX Control.  Any requested local copy of a 
GraphWorX-based HTML file generated from the Web Publishing Wizard is stored in this folder. 
(See the “Web Publishing Wizard” section below for more information on exporting and publishing 
HTML files from GraphWorX displays.)  The ProjectWorX database maintains a record of which 
local GraphWorX display (.gdf) files each of these HTML files depends on. Documents in this folder 
can be added, removed, copied, pasted, opened, edited, added to Microsoft Visual SourceSafe, 
searched, replaced, and packed the same way items from other categories can. 
 

 
GraphWorX-Based HTML Subtree 

 
Local HTML Files 
The Local HTML Files subtree of the WebHMI tree stores basic HTML files that were not generated 
from the Web Publishing Wizard.  Here you can add, delete, edit, and maintain various HTML files.  
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Local HTML Files Subtree 

 
Published Documents 
The Published Documents subtree of the WebHMI tree, shown in the figure below, maintains a list 
of all HTML files that have been exported/published from ProjectWorX.   
 

 
Published Documents Subtree 

 
In the right-hand pane of the ProjectWorX Console, each item is listed as a URL with the date it was 
published, as shown in the figure below. For information about publishing files from ProjectWorX, 
please see "Using the Web Publishing Wizard." 
 

 
List of All Documents Published From ProjectWorX 

 
Launching the Web Publishing Wizard in ProjectWorX 
The Web Publishing Wizard in ProjectWorX performs two basic operations: 
 

1. The Wizard creates HTML files based user-specified GraphWorX display (.gdf) files. 

2. The Wizard then either "exports" (saves) the HTML files to a user-specified directory on the 
 local drive and/ or "publishes" (uploads) the HTML file to a user-specified Web server URL 
 address (i.e. over the Internet or an intranet). 
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Web Publishing Wizard in ProjectWorX Console 

 
You can open the Web Publishing Wizard dialog from the ProjectWorX console in the following 
ways: 
 
• Select the project root and then choose Publish Wizard from the Tools menu, as shown in the 
figure below. In this case, both the Publish Web Page field and the Based on Source File field in 
the Web Publishing Wizard dialog are read-only and contain the text “(Display Name).htm” and “(All 
GraphWorX Displays in Project),” respectively.  The browse (…) button is also disabled. 
 

 
 

Opening the Publishing Wizard From the Tools Menu 
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• Right-click on the Applications/GraphWorX/Displays tree and select Publish All Displays, 
 as shown in the figure below.  In this case, both the Publish Web Page field and the Based on 
 Source File field in the Web Publishing Wizard dialog are read-only and contain the text 
 “(Display Name).htm” and “(All GraphWorX Displays in Project),” respectively.  The browse (…) 
 button is also disabled. 
 

 
Publishing All GraphWorX Displays in a Project 

 
• Right-click on a GraphWorX display and select Publish HTML, as shown in the figure below. In 
 this case, the Based on Source field in the Web Publishing Wizard dialog is read-only and 
 contains the name of the selected GraphWorX display.  The browse (…) button is also disabled. 
 

 
Publishing a GraphWorX Display File 

 
• Right-click on the Applications/WebHMI/GraphWorX-Based HTML tree and select New 
 HTML Document, as shown in the figure below. In this case, you need to specify a GraphWorX 
 display file in the Based on Source File field by browsing for the file or by typing in the file 
 name. You also need to specify the name of the new HTML file in the Publish Web Page field. 
 

 
Creating a New HTML File in a Project 
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Export and Publish Options in ProjectWorX 

 
The Web Publishing Wizard in the ProjectWorX console, shown in the figure below, generates an 
HTML file based on one or more user-specified GraphWorX display (.gdf) files. Then the Wizard 
either "exports" (saves) the HTML file to a user-specified directory on the local drive or "publishes" 
(uploads) the HTML file to a user-specified Web server URL address (i.e. over the Internet or an 
intranet).  
 
You have the following options when using the Web Publishing Wizard for a project: 
 
• Export and/or publish all GraphWorX display files in the project. 
• Export and/or publish a single GraphWorX display file in the project. 
• Export a display file locally 
• Publish a display file to a Web server. 
 

Note 
Both the Publish to Web Server and Export Local Copy actions can be performed at the same 
time. 

 

 
Web Publishing Wizard in ProjectWorX Console 

 
Exporting and Publishing Multiple GraphWorX Display Files in ProjectWorX 
In ProjectWorX, you can export and/or publish multiple GraphWorX display files using the Web 
Publishing Wizard. 
 
To export/publish all displays in a project: 



ProjectWorX 

6.7 

 
1. Select the project root and then choose Publish Wizard from the Tools menu, or right-click on 
 the Applications/GraphWorX/Displays tree and select Publish All Displays, as shown in the 
 figure below. 
 

 
Launching the Web Publishing Wizard 

 
2. This launches the Web Publishing Wizard, as shown in the figure below. In this case, both the 
 Publish Web Page field and the Based on Source File field in the Web Publishing Wizard 
 dialog are read-only and contain the text “(Display Name).htm” and “(All GraphWorX Displays in 
 Project),” respectively.  The browse (…) button is also disabled. 
 

 
Publishing All GraphWorX Displays in a Project 
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Exporting and Publishing Individual GraphWorX Display Files in 
ProjectWorX 
In ProjectWorX, you can export and/or publish individual GraphWorX display files using the Web 
Publishing Wizard.  
 
To export/publish a single display in a project: 
 
Right-click on a GraphWorX display and select Publish HTML, as shown in the figure below.  
 

 
Launching the Web Publishing Wizard 

 
1. This launches the Web Publishing Wizard, as shown in the figure below. In this case, the Based 
 on Source File field in the Web Publishing Wizard dialog is read-only and contains the name of 
 the selected GraphWorX display.  The browse (…) button is also disabled.  
 
2. In the Publish Web Page field of the Web Publishing Wizard, specify the name of the HTML file 
 that will be created. The .gdf file name is filled in by default, but you can give the HTML file a 
 different name. 
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Publishing a GraphWorX Display in a Project 
 

Note 
You can also right-click on the Applications/WebHMI/GraphWorX-Based HTML tree and select 
New HTML Document, as shown in the figure below, to export/publish a GraphWorX display. This 
launches the Web Publishing Wizard. In this case, you need to specify a GraphWorX display file in 
the Based on Source File field by browsing for the file or by typing in the file name. You also need 
to specify the name of the new HTML file in the Publish Web Page field. 

 

 
Creating a New HTML File in a Project 
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Exporting a Display File Locally in ProjectWorX 
To export a GraphWorX display to a directory on the local drive: 
 

1. Right-click on the Applications/WebHMI/GraphWorX-Based HTML tree and select New 
HTML Document, as shown in the figure below.  
 

 
Launching the Web Publishing Wizard 

 
2. This launches the Web Publishing Wizard, as shown in the figure below. In the Based on 
 Source File field of the Web Publishing Wizard, you must specify the name of the GraphWorX 
 display (.gdf) file to be exported, as shown in the figure below. To choose a display, click the … 
 button to the right to browse for a file. Select a file and then click Open. The directory path and 
 the file name are shown in the text field.  
 

 
Exporting a Display File Locally in ProjectWorX 
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3. In the Publish Web Page field of the Web Publishing Wizard, specify the name of the HTML file 
 that will be created.  
 
4. In the Publishing Options field, the Export Local Copy check box is checked by default. 
 Specify the local directory path name to which you want to export the HTML file. You can select 
 a recently used path from the drop-down list, or click the … button to browse for a destination 
 directory. Select the directory and click OK. The local directory pathway you selected appears in 
 the Export Local Copy field of the Web Publishing Wizard. 

 
Note 

By default, ProjectWorX saves the HTML file to the (local) Applications/WebHMI/GraphWorX-
Based HTML tree. From there, the HTML file can be edited and published again in the future.   

 
5. Click the OK button to generate the HTML file. The new HTML file is saved to the local directory 
 pathway specified in the Export Local Copy field. 
 

Note 
Both the Publish to Web Server and Export Local Copy actions can be performed at the same 
time. 

 
Publishing a Display File to a Web Server in ProjectWorX 
To publish the HTML file to a directory on a Web server (i.e. over the Internet or an intranet): 
 
1. Right-click on the Applications/WebHMI/GraphWorX-Based HTML tree and select New 
 HTML Document, as shown in the figure below.  
 

 
Launching the Web Publishing Wizard 

 
2. This launches the Web Publishing Wizard, as shown in the figure below. In the Based on 
 Source File field of the Web Publishing Wizard, you must specify the name of the GraphWorX 
 display (.gdf) file to be published, as shown in the figure below. To choose a display, click the … 
 button to the right to browse for a file. Select a file and then click Open. The directory path and 
 the file name are shown in the text field.  
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Publishing a Display File to a Web Server 

 
3. In the Publish Web Page field of the Web Publishing Wizard, specify the name of the HTML file 
 that will be created.  
 
4. In the Publishing Options field, check the Publish to Web Server check box and type in the 
 URL address of your Web server with the complete directory indicating where you want to 
 publish the HTML file, as shown in the figure above. In the sample Web server URL address 
 shown above ("http://www.myserver.com/WebHMI/Samples"), the various components are: 
 
• http://www.myserver.com: IP address (server name) of the WebHMI Server 
• WebHMI: Name of the WebHMI server root directory  
• Samples: Name of the directory on the server to which the HTML file will be saved 
 
5. Click the OK button to generate the HTML file. The new HTML file is uploaded to the Web 
 server and then saved to the URL address path specified in the Publish to Web Server field.  
 

Note 
By default, ProjectWorX also saves the HTML file to the (local) 
Applications/WebHMI/GraphWorX-Based HTML tree. From there, the HTML file can be edited 
and published again in the future.   

 
Note 

Both the Publish to Web Server and Export Local Copy actions can be performed at the same 
time. 
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Publishing Customization Options 
The Web Publishing Wizard contains some customization options for exporting/publishing HTML 
files. Clicking the Advanced button on the Web Publishing Wizard dialog opens the Web 
Publishing Properties dialog box, which contains the following tabs: 
 
• Server Switching Support 
• Screen Resolution Settings 
• Publishing Options 
 
Server Switching Support 
The Server Switching Support tab of the Web Publishing Properties dialog box, shown in the 
figure below, allows you to enable or disable GenBroker support for the exported/published HTML 
file. Here you can specify which GenBroker configuration file (.gbc or .gbx) will be activated. The 
GenBroker configuration file establishes the settings for OPC data communications between the 
clients and the Web server. 
 

 
Server Switching Support Settings 

 
There are three available options for GenBroker support: 
 
• None: GenBroker support is not active. 
• As Configured in WebHMI Settings: This setting uses the default URL address of the 
 GenBroker configuration (.gbc) file as specified in the WebHMI installation. 
• User Defined: When this option is selected, the GenBroker Configuration File URL field 
 becomes available, allowing you to specify the URL address of the GenBroker 
 configuration(.gbc) file.  
 
Clients can receive data from different WebHMI servers, but communication can be established only 
to one server at a time. The server to which a client connects depends on the type of information 
that the client requests. If Server A, for example, does not contain the components necessary to 
answer the client's request, the request will be forwarded to Server B, or Server C, and so on. 
 

Note 
For information about configuring GenBroker settings, please see the GenBroker Configurator 
Help documentation. 
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Screen Resolution Settings 
The Screen Resolution tab of the Web Publishing Properties dialog box, shown in the figure 
below, determines the screen resolution and size of the GraphWorX Viewer ActiveX control, which 
is referenced in the generated HTML file and then downloaded to a client PC when the HTML file is 
viewed in the client's Web browser.  You can specify the screen size in the Width and Height fields 
in terms of pixels (px) or percentage (%). Click the Resolutions button to select from a pop-up 
menu of standard screen resolutions, as shown in the figure below. 
 

 
Screen Resolution Settings 

 
Publishing Options 
The Publishing Options tab of the Web Publishing Properties dialog box, shown in the figure 
below, enhances the publishing process. By default, the Web Publishing Wizard provides support 
for related files detection (for more details, see the Multiple Display Support section). The multiple 
display detection could be a rather lengthy process. You can speed up the process by disabling the 
Enable Multiple Display Support option. This is especially useful, if you have already published 
your project files to the Web server, and now you want to update display you have changed.  
 
The multiple display detection mechanism ensures that the Web page will be published properly for 
the source file. Disabling the Multiple Display Support may cause publishing of an incomplete web 
page, which may result in unexpected behavior. Therefore, it is suggested to disallow publishing of 
the Web page. You can do so by enabling the Publish Display File Only option. 
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Publishing Options 

 
Publishing Files at a Later Time 
The Web Publishing Wizard, ProjectWorX saves the generated HTML file to the (local) 
Applications/WebHMI/GraphWorX-Based HTML tree. The advantage of storing a local copy of an 
exported HTML file is that it can be edited, packed, moved, unpacked, and then published again at 
any time. This saves you the burden of having to re-export the same GraphWorX display file to a 
new HTML file.  You can use this option in any of the following ways: 
 
• Right-click on any HTML file in the Applications/WebHMI/GraphWorX-Based HTML tree and 
 select Publish HTML from the pop-up menu, as shown in the figure below. 
• Right-click on any HTML file in the Applications/WebHMI/Local HTML Files tree and select 
  Publish HTML from the pop-up menu.  
 

Note 
Selecting Edit HTML from the pop-up menu opens the source code for the HTML file. 

 

 
 

Publishing a Locally Stored HTML File 
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• Right-click on the GraphWorX-Based HTML Files tree and select Publish All Files from the 
 pop-up menu, as shown in the figure below. 
• Right-click on the Local HTML Files tree and select Publish All Files from the pop-up menu. 
• Right-click on the WebHMI tree and select Publish All Files from the pop-up menu. This 
 publishes all HTML files in the WebHMI tree. 
 

 
 

Publishing All Locally Stored HTML Files 
 
All of these actions open the Publish HTML File to Web Site dialog box, as shown in the figure 
below. The Qualified WWW Folder field in this dialog is identical to the Publish Location field in 
the Web Publishing Wizard dialog and is stored in the same place in the registry if the action is 
successful. This specifies the location of the Web server to which the HTML file will be published. If 
the export/publish action is successful, a "publish” action on an HTML file in the Local HTML Files 
tree simply uploads the HTML file to the Web server. A “publish” action on an HTML file in the 
GraphWorX-Based HTML Files tree uploads both the HTML file and its attached GraphWorX 
display (.gdf) file to the Web server. 
 

 
 

Specifying a Web Server Location for HTML Publishing 
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Web Publishing Log 

 
When exporting/publishing only one file from a GraphWorX display to HTML, you are alerted if 
anything goes wrong in the process. If, however, multiple files are being exported/published 
simultaneously, a log is generated so the operation will not be halted with each file that cannot be 
exported/published. After a batch publishing operation from the GraphWorX-Based HTML Files 
tree, a log file appears showing the success or failure of each attempt to publish the files.  If this log 
file is needed at a later time, it can be found in the project root, as shown in the figure below. 
 

 
 

Location of Web Publishing Log File 
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